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Service Overview 
  
TD Commercial Banking’s Cheque Fraud Protection Service (CFP) provides you with a web-based 
facility for managing cheques clearing through your Canadian and U.S. dollar business accounts and for 
detecting potential fraudulent activity. 
 
The service is available 24 hours, 7 days per week except during routine scheduled maintenance hours. 
 

Software and Hardware Requirements 

• Microsoft PC or Apple Macintosh 

• Microsoft Windows 98 or higher. 

• Microsoft Internet Explorer 6.x (with 128 Bit Encryption) or later version or Google Chrome. 

• A 700 MHz or faster processor. 

• MacOS 10 and the latest certified release of Safari. 

• The application requires: 

o The ability to write cookie data on the PC 

o Users must configure their browsers to accept cookies. 

Image Viewer 

Daeja Viewer 

• The Daeja Viewer is the default viewer used to view cheque images. 

• The latest 5.x release leverages the HTML5 standard built into modern browsers. You do not 
need to install any other applications or add-ons. 

• The Daeja Viewer Virtual will allow you to view, zoom, rotate and print images. 

• The following are the minimum browser requirements: 
• Chrome version 64.0.3283 
• Internet Explorer 11 
• Safari 9.x 

• The following are the minimum operating system requirements:  
• Windows 8 or 10 
• Mac OS X v10.x and above 

 

Native Viewer 

• The Native Viewer provides a simplified view of the cheque only without the 
additional view features as the Daeja Viewer. 

 
• To access Native Viewer, select the option 'Image Viewer' on the User Profile 

page.  
 
• The new Native viewer will only allow the user to ‘view’ an image, there is no 

added manipulation functionality e.g. zoom in. 
 

 

HTML5 Viewer: 

• The HTML5 viewer is used to view cheque images and leverages the HTML5 
standard built into modern browsers and does not require other applications or 
add-ons. 
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• The HTML viewer will allow you to view, zoom, rotate and print images. 
 
• The following are the minimum browser requirements:  

• Chrome version 64.0.3283 
• Internet Explorer 11 
• Safari 9.x 

 
• The following are the minimum operating system requirements:  

• Windows 8 or 10 
• Mac OS X v10.x and above 

 

Selecting the Image Viewer setting from user set up 

During user creation the System Administrator can select the Image Viewer setting to set up the user 
profile. 

 

 

 

 

 

 

 

 

 

 

 

Modify Image Viewer setting while the user is logged on 

1) To change the image viewer setting for an existing profile, you must click on the ‘User 
Profile’ link; this will take you to the user profile page. 
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2) From the User Profile page, select an Image Viewer type from the dropdown and click 
Submit. 

 
 

 

 
 

 
 
 
 
 

3) You will be informed that your profile has been updated. You must log out of the 
application and log in again for the new settings to apply. 
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Positive Pay Service 

Overview 
 
On each day that you issue cheques, you transmit to us an Issued Cheque File by 10:30 p.m. 
ET containing details for each cheque issued by you since the previous business day. 
 
Alternately, you may create an individual issue record for each cheque issued by you since the 
previous business day via the on-line CFP Service. 
 
If you transmit an Issued Cheque File to us, we will provide you with an e-mail notification that 
we have received the file and uploaded the details of the issued cheques to the on-line CFP 
Service. If we reject any issued cheques for any reason we will instruct you to access the on-
line CFP Service to 
view your Issued File results. 
 
We will compare all presented cheques to your issued records. For Positive Pay Service, we 
compare each presented cheque against the serial number and amount in your issued record. 
For Payee Match Service, we also compare the payee name on the presented cheque against 
the payee name provided in your issued record. 
 
Any presented cheques that do not match your issued cheque information will be presented to 
you as exceptions. Exception cheques will be available for your review by 9 a.m. ET via the 
on-line CFP Service. We will send you a courtesy e-mail around 10:30 a.m. ET to advise you 
that: 

• There were no exception cheques (if your CFP account is subscribed to receive 
a ‘null’ e-mail) 

• There are exception cheques that still require your pay or no pay decision 
• There may be cheques returned since our last e-mail 
• There may be cheques that we were not able to return since our last e-mail 

(recourse may have been lost or the item’s amount may have been misread by 
the system so only needed to be adjusted and not returned) 

  
You can opt to have Post-Dated and Stale-Dated cheques presented as exceptions (with 
applicable fees). Normally, Post-Dated and Stale-Dated cheques clear without an exception. 
 

Positive Pay Service Flowchart 
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Pay/No Pay Decision 
 
For each exception cheque, you will access the on-line CFP Service exception management 
screen and instruct us by the notification deadline either to pay or not to pay the exception 
cheque. If you choose not to pay an exception cheque, you must select the appropriate reason 
for non-payment. If we do not receive your instructions on an exception cheque by the 
notification deadline, we will revert to your default instructions and either pay or return the 
exception cheque according to your instructions. You advised us of your default decision in 
your Cheque Fraud Protection Service Schedule. 

 

Notification Deadline 
 
Canadian Dollar cheques – 2:00 p.m. local time 
 
U.S. Dollar cheques – 12:00 p.m. ET 

Getting Started 

A number of things must take place before you can begin to use the Cheque Fraud Protection Service. 
Your TD Manager, Cash Management and assigned CFP Implementation Manager will tailor CFP to meet 
your business needs, supply you with the documentation required to implement the service, and will help 
you get started. 

 
Your TD team will: 
 

• Assign a CFP account number 
• Advise you on the cheque preparation and quality testing procedures required 

before activating your CFP account 
• Provide you with a support contact list 
• Provide you with a ‘Go Live’ date 

 

Your CFP Account Number 

Your CFP account number is imprinted within the MICR (Magnetic Ink Character Recognition) line on all 
cheques designated for CFP processing. CFP cheques are charged to your specified dedicated 
business chequing account. Your Manager, Cash Management documents your bank account numbers, 
as well as the CFP Service option you selected, on a CFP Application Form for the purposes of setting 
up your profile on the CFP Service. 
 
The default for a CFP account is to post all CFP cheques presented on a given day to your TD business 
account as a single debit. You can request that CFP cheques over a pre-determined limit (minimum 

$1,000) be posted to your account individually. The remaining cheques under this amount will continue to be 

included in the List Post entry. 

Note: To ensure your information remains accurate, complete and up to date, advise your Manager, 
Cash Management of any changes or if you want your service requirements change 

Optional Disbursement Category Service 

You can assign up to 999 disbursement categories to your CFP account number and receive reports and 
cheque information for each category assigned. You differentiate each disbursement category by the first, 
second or third digits of your cheque number. What your disbursement categories represent is up to you they 
may, for example, represent your company’s divisions, departments, geographical locations or payroll 
groupings. 
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Preparation of Cheques for CFP Service 

CFP uses an automated cheque processing system based on Magnetic Ink Character Recognition (MICR) 
encoding technology. To ensure that your cheque information can be processed through the CFP Service, 
specific cheque encoding, printing and testing procedures must be completed, both before your CFP 
account is activated and at any time afterwards when you need a supply of new or additional cheques. 

 
To prepare your cheques for CFP processing, you will need to: 

 
• Arrange to have new cheques printed with your CFP account number, formatted to 

MICR print standards and specifications. Your Implementation Manager will provide you 
with a completed MICR Specification Form with your introductory CFP letter. 

• Supply your Implementation Manager with 15 cheque samples, selected at random for 
quality assurance testing. 

 

The MICR Specification Sheet: 

You will need a separate MICR specification sheet if: 

• Your cheques are payable in U.S. funds 
• Your cheques are to be numbered by disbursement category (use a separate MICR 

specification sheet for each disbursement category) 
• You have more than one CFP account number 

 
Once you receive your MICR specification sheet(s) from your Implementation Manager, the only 
information you will need to record on the form will be your cheque serial starting number. All 
other information on the form is pre-printed or completed by your Implementation Manager. 
 

Document the following cheque serial number information on your MICR specification sheet: 

• Number of digits in your cheque serial number (choose from a 6 to 10-digit serial 
number) 

• The starting serial number (enter any starting number, though the usual starting number 
for a new CFP account is 000001, 0000001, 00000001, 000000001 or 0000000001 for 
a six, seven, eight, nine- or ten-digit serial number respectively). 

 
When re-ordering CFP cheques, you should always ensure that the serial numbers are a continuation of 
the previous cheque order.  

Note that you cannot re-use cheque serial numbers as the CFP Service does not accept duplicate 
serial numbers. 

If you are using disbursement categories, you may use up to the first three digits of the serial number 
(counting from the left) to differentiate disbursement categories. Though any sequence or combination may 
be used, the usual starting number is 1, 01, or 001 for the first category: 2, 02 or 002 for the second; and 
3, 03 or 003 for the third etc. When using the disbursement category option, your cheque serial numbers 
must have a minimum of seven digits with the first being the identification digit. 

Once all information is completed, forward the MICR specification sheet to your printer. The printer you 

select to produce your cheques must comply with the print standards and specifications detailed in the 

Canadian Payments Association (CPA) Manual. 

Quality Assurance Testing  

All newly printed CFP-encoded cheques (including reorders) must pass the TD Commercial Bank’s 
quality assurance test, which ensures that your cheques are properly encoded and printed and can 
be processed through the automated CFP Service. 

When you are ready to submit your cheques for testing, forward 15 sample cheques marked “Void” to 
your Implementation Manager. To ensure testing is accurate, it is important that you randomly select 
these cheques from your total shipment, including cheques from the top, middle and end stacks. 
Testing is completed in approximately 15 days. 
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If your cheques do not pass testing and are rejected because they do not meet the specifications and 
standards given in the CPA manual, you will receive a letter detailing why they were rejected, and you 
will need to approach your printer for replacements. 
 

Payee Name Verification 

If you subscribe to Positive Pay Payee Match, you will need to ensure that the payee name on your 
cheque is in the correct position to be read by our Payee Name Verification engine. Please use the 
following Optical Character Recognition (OCR) Guidelines to maximize the readability of the payee 
name. 

Fonts 

• Font should be at least 10 points in size. 
• Fonts should be fixed pitch. 
• Fonts should NOT be in bold or italics. 
• When the payee name is printed in all upper case instead of mixed case, we have 

noticed an improvement in OCR quality. 
• The following fonts are known to be successful with the OCR process: 

o Arial 

o Century Schoolbook 

o Comic Sans MS 

o Courier 

o Courier New 

o Gaudy Old Style 

o Georgia 

o Helvetica 

o Microsoft Sans Serif  

o Tahoma 

o Times New Roman 

o Veranda 
• The following fonts are known to cause OCR errors: 

o Agency FB 

o Garamond 

o Bradley Hand ITC  

o Monotype Corsiva 

Print Quality 

• The payee name MUST be in machine print (not hand print). 
• The payee name should be printed on a laser printer (not dot matrix). 
• The ink used to print the payee name should be black (not coloured). 

 

Background 

• The background of the cheque should be light in colour, to create sufficient contrast 
between the payee name and the background. 

• The background of the cheque should be free of any images or dark gradients that 
would interfere with the reading of the payee name. 

 

Layout 

• The payee name should be left aligned. 
• The spacing in between payee name lines should be even. 
• Each word in the payee name should be separated by only one space (no more). 
• No other elements, such as the amount field, signatures, or the field label (“pay to the order of”) 

should come within half an inch of the payee name. 
• The first line of the payee name should start about three-quarters of the way down the cheque, and 

the left edge of the payee name should be about 0.75 inches from the left edge of the cheque. 
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Day to Day Support 

Please refer to the following contact list whenever you need additional information or guidance: 

 

Issued Cheque File Information 
 

• As a Positive Pay customer (if you choose the file transmission option), issued cheque 
information will need to be communicated to TD Bank via electronic transmission. 

• If you subscribe to the Payee Match Service, ensure that you have entered the payee 
name in the Issued Cheque File exactly as it appears on the actual cheque to avoid any 
unnecessary exceptions. 

 

Pre-implementation setup on your company’s and TD’s system is required so that transmission can take 
place. Before you can send live files, your transmission files must pass the CFP compatibility test. 
Testing ensures that your data records are formatted to our specifications and can be processed through 
the CFP System. Testing is completed in approximately 5 days. 
 
You should retain backup files of your previous and current records. If an Issued Cheque File is lost, or 
otherwise cannot be processed you may be requested to re-transmit your backup file for processing. 

 
This section: 

 
• Details the processes involved in sending CFP files by Mainframe and/or Web Business 

Banking File Transfer Service. 
• Provides the format for your mainframe header record if you choose to send mainframe 

transmissions to TD 
• Provides a sample of the e-mail notification you will receive when we process your file 
• Provides formats for your CFP Issued Cheque File 

 

Mainframe File Transmissions: 

If you intend to transmit your Issued Cheque File to us via mainframe transmission, you will be required 
to complete a transmission schedule. This schedule tells us when you will be sending your Issued 
Cheque Files. Schedule your input transmission so that it is received no later than 10:30 p.m. ET. 

 

Logical File: A Logical File consists of one header record, one or more data records and one trailer 

record. 

 
Physical File: A Physical File is one transmission to us and may consist of several logical file. If sending 
multiple logical files, each file must immediately follow the previous trailer record. Do not separate files by 
blank records. 

 
For mainframe file transmission, you must put a transmission header record on each mainframe file. This 
record provides us with customer and application information and it must be the first record on each of 
your ‘host-to-host’ (mainframe) transmissions. 

 

Type of Support Who to contact  

Day to Day Support Issues 

Cash Management Support at 416 982-4567 or 1-800-
668-7327, 8AM - 8PM ET (English) 

or 
1-800-567-4455, 9AM - 5PM ET (French) 

Changes to your service requirements Your Manager of Cash Management 
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Your mainframe file will be rejected before it gets loaded to the CFP Service if the: 

• Header record is missing 
• Application identifier (FRS) is invalid or missing 

 
If your file is rejected at this stage, no e-mail acknowledgement advice will be produced. If you have a 
transmission window assigned, and no file has been received by the end of your secondary window, you will 
be contacted. If your transmission was not scheduled, you will not be contacted. 

Transmission Header Record Format 

Field No.  
Character 
Position 

Length  Type1 Content Explanation/Value  

01 1 - 5 5 A $$ADD always $$ADD 

02 6 1 A/N spaces filler (reserved)  

03 7 - 9 3 A ID= always ID= 

04 10 - 14 5 A/N customer number 
Communication 

customer number, 
assigned by TD Bank 

05 15 - 17 3 A 
application 
identifier 

always FRS 

06 18 1 A/N spaces filler (reserved) 

07 19 - 26 8 A batch ID always BATCHID 

08 27 1 A single quote always 

09 28 - 42 15 A 
customer short 

name 
agreed upon by you & 

TD 

10 43 1 A/N spaces filler (reserved)  

11 44 - 51 8 A password 
8-char. Password 
assigned by TD 

12 52 1 A single quote always 

13 53 - 80 28 A/N spaces filler (reserved)  

 

1Valid Data Types: A= alpha characters (A – Z); N= numeric characters (0 – 9); A/N= alphanumeric characters (A – Z; 0 

– 9) 

Sending Your CFP Issued Cheque File Using Web Business Banking 

The following is an overview of how to upload a CFP Issued Cheque file to TD Commercial Banking for 
processing via Web Business Banking File Transfer Service. For complete instructions on how to upload 
a CFP Paid Cheque File, please refer to the on-line help screens on TD Commercial Banking’s Web 
Business Banking site. 
 

Procedure: 
 

1. Log on to Web Business Banking. 

2. Select File Transfer option from the top horizontal menu bar. 

3. Click on Send File from the left vertical menu to display the Send File. 

4. Select Cheque Fraud Protection Service from the Service drop-down menu. 

5. Select the appropriate file description from the Service Description drop-down menu. 

6. Click on the Continue button to open a file transport service window which will allow 
you to specify the name of the file you are sending. 
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7. Click on the Browse button and highlight the file you wish to send. Click the Open button. 

Note: You can also type the name and full path directly into the file name text box. 

8. Click on the Send to Bank button to begin the upload. The status bar at the bottom of 
your browser window will show the upload progress. Once the upload is complete, a 
confirmation message will be displayed. 

9. Close the File Transport Service Window to return to Web Business Banking. 

 
Note: To ensure that your file has been processed successfully, please refer to the on-line CFP Issue 

File Search screen 

Issued Cheque File Consolidated E-mail Advice 

When you send a CFP Issued Cheque File transmission to us, we will send a bilingual e-mail advice 
within approximately one hour to designated e-mail addresses to advise that we have received your 
file and uploaded the details of the issued cheques to the on-line CFP service. Please note that the e- 
mail advice may be sent to a maximum of five e-mail addresses. We recommend that you create a 
group e-mail address. This consolidated e-mail will report on all positive pay CFP accounts in a profile 
for which an issue file has been sent in the past hour. 
 
If we reject an issued cheque the e-mail will instruct you to access the on-line Issue File Search 
screens for details. 

Subject : Issued File Confirmation/Confirmation de fichiers de chèques émis 

 
One or more records from the Issued File(s) with the following identifier(s) has not been loaded. Please login to 
the Cheque Fraud Protection system and view the Issued file for further details. 

 
Issued Files Affected CFP 
Account 1500000  2000 

 

All records from the Issued File(s) with the following identifier(s) have been loaded. No 

action is required. Issued Files Loaded CFP Account 

1400000 1000 
 

 
Please do not reply to this email. 

If you require immediate assistance, please contact Cash Management Support at 416 982-4567 or 1-800-
668- 7328, 8 a.m. - 8 p.m. ET (English), or 1-800-567-4455, 9 a.m. - 5 p.m. ET (French). 

 
--------------------------------------------------------------------------------------------------------------------------------------- 
 
Un ou plusieurs enregistrements du fichier de chèques émis comprenant les identifiants suivants n’ont pas été 
téléchargés. Veuillez accéder au système de protection contre les fraudes par chèques et consulter les fichiers de 
chèques émis pour obtenir plus de détails. 

 
Fichier de chèques émis Compte SPFC 

touché 1500000 2000 

 
Tous les enregistrements du fichier de chèques émis comprenant les identifiants suivants ont été 
téléchargés. Aucune mesure n’est requise. 

 
Fichier de chèques émis Compte SPFC 

téléchargé 1400000 1000 
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Sample e-mail advice: 

Note: If you do not receive an email notification within one hour of sending your file call our Cash 
Management Support at 416 982-4567 or 1-800-668-7328, 8 a.m. – 8 p.m. ET (English), or 1-800-567- 
4455, 9 a.m. – 5 p.m. ET (French) to advise them. In the interim, you can perform an Issued File Search to 
see if we have received your file. Similarly, if your file does not appear in the CFP System, please call our 
Cash Management Support so we can check if your file was rejected prior to loading into the CFP 
service. 

 

Issued Cheque File Processing Timelines 

We process Issued Cheque Files hourly according to the following timetable: 
 

File Upload Time 
Approximate e-mail advice 

delivery time 

7:00 a.m. 7:10 a.m. 

8:00 a.m. 8:10 a.m. 

9:00 a.m. 9:10 a.m. 
10:00 
a.m. 

10:10 a.m. 

11:00 
a.m. 

11:10 a.m. 

12:00 
p.m. 

12:10 p.m. 

1:00 p.m. 1:10 p.m. 

2:00 p.m. 2:10 p.m. 

3:00 p.m. 3:10 p.m. 

4:00 p.m. 4:10 p.m. 

5:00 p.m. 5:10 p.m. 

6:00 p.m. 6:10 p.m. 

7:00 p.m. 7:10 p.m. 

8:00 p.m. 8:10 p.m. 

9:00 p.m. 9:10 p.m. 

10:00 
p.m. 

10:10 p.m. 

11:00 
p.m. 

11:10 p.m. 
 

e.g. You submit your Issued Cheque File at 8:30 a.m. We upload your Issued Cheque File at 9:00 a.m. 
At approximately 9:10 a.m. you will receive your e-mail advice. 

 

 

 

 

 

 

 

 

Veuillez ne pas répondre à ce courriel. 

Si vous avez besoin d’assistance immédiate, veuillez communiquer avec le Centre de soutien de gestion de 
trésorerie au 1-800-567-4455, de 9 h à 17 h, HE (en français), ou au 416-982-4567 ou au 1-800-668-7328, de 8 
h à 20 h, HE (en anglais). 
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CFP Issued Cheque File Formats 

All CFP files must be formatted to TD Commercial Banking’s standard 80-byte output file formats. 
These standard layouts, which are detailed in this section, are the same regardless if you are sending 
the file through Web Business Banking File Transfer Service or via mainframe. 

 
The Payee Name in the Issue File must be an exact match to the Payee Name on the issued cheque or else 
an exception will be presented. 

CFP Issued Cheque File Format 

Header Record: 

 

Data Record: 

Position Description Type1 Length Sample Value 

1 Record Type A 1 Always H upper case 

2 - 6 CFP Account Number N 5 95959 

7 - 11 TD Branch Transit N 5 10202 

12 - 18 CDA Account Number N 7 1234567 

19 - 48 CFP Account Name2 A/N 30 ABC Company Ltd 

49 - 56 File Date (yyyymmdd) N 8 20071231 

57 - 61 Reserved A/N 5 Filled spaces 

62 - 69 File Creation Number A/N 8 ABC123453 

70 - 78 Reserved A/N 9 Filled spaces 

79 Version Flag A/N 1 1 indicates 40-byte payee name4 

80 Header Flag A/N 1 N indicates 5-digit CFP number 

Position Description Type Length Sample Value 

1 Record Type5 A 1 I /S /V upper case 

2- 11 Serial Number N 10 12345 

12- 23 Amount N 12 

000000010000 (=100.00) 
 

NOTE: although this field allow for 12 
characters, the maximum allowable amount 

for clearing purposes is 99,999,999.99. 

24 - 31 
Issue Date 

(YYYYMMDD) 
N 8 20071231 

32 - 40 Reserved A/N 9 Filled spaces 

41 - 80 Payee Name6 (see note) A/N 40 Roy Smith7 
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Trailer Record: 

 
 

 

 

 

 

 

 

 

1 Valid Data Types: A = alpha characters (A –Z); N=numeric characters (0-9), A/N = alphanumeric characters (A-Z; 0-9)  
2 Supplied by you (TD recommends you use your short name)  
3 File Creation Number – increment by one (1) for every subsequent file for each CFP account number.  
4 Due to limitations in the ANSI Standards, if you subscribe to Payments Consolidation, you can only choose a 25-       

character payee name file option in which case this field would be space-filled.  
5 Valid Record Types: I = Issue, S = Stop, V = Void  
6 The Payee Name in the Issue File must match the Payee Name on the cheque. For example, if an issue record      

contains a Payee Name of ‘John Smith’ and the cheque contains a Payee Name of ‘Smith, John’, an exception will be   
presented.  

7 French language characters will be accepted but may not display correctly on the CFP Web. If an exception is raised 

for a French character, please contact the Cash Management Support at 416 982- 4567 or 1-800-668-7328, 8 a.m. – 8 
p.m.  ET (English), or 1-800-567-4455, 9 a.m. – 5 p.m. ET (French) to advise them 

Optional Paid Cheque File Information 

You may choose to receive an optional Paid Cheque File. Paid Cheque Files are available for 
delivery according to the following frequencies: 

 
• Month-end 
• Weekly (Fridays) plus Month-end 
• Weekly (Fridays) 
• Daily 

 
The CFP Paid Cheque file is available in either TD Commercial Banking’s standard paid file format or in 
EDI 821 format. Items are listed in serial number order and include all cheques presented for payment 
on the previous business day including exception cheques (paid against stop, paid no issue etc.). The 
paid cheque information can be used by your company to compare presented items to your record of 
issued cheques and confirm their validity. 
 

Action: 

 
• Upload your Paid Cheque File to your accounting program. Where you have already 

identified cheques to be stopped or where presented cheque dollar values do not match 
your issued cheque records, your accounting program should automatically flag any 
exceptions to you. 
 

• Please be assured that we will be automatically returning all cheques where you have 
provided us with stop payment instructions. Your business account will be credited once 
the cheque has been returned. 
 

• At any time during the business day, you can verify that we are actioning these items by 
searching for the paid item in CFP. Any paid against stop items will appear with a 
"pending return" status. All items pending return are processed at the end of business 
between the hours of 4 and 5 p.m. local time. Once the item has been physically 
returned, the CFP system will update the status of the item to "returned". You may also 
choose to download a Returned Report which will identify to you all cheques which have 
been returned that day. 
 

Position Description Type Length Sample Value 

1 Record Type A 1 Always T upper case 

2 - 10 
Total Data 
Records 

N 9 000000001 

11 - 23 Total Amount N 13 0000000010000 (100.00) 

24 - 80 Reserved A/N 57 Filled spaces 
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• Encoding errors under $20.00 should be adjusted by 10 a.m. each business day. You can 
verify updates to an encoding error by performing a search on the paid item in CFP. You 
will see both the original paid amount and the adjustment amount with your search 
results. You may also choose to download an Adjustment Report which will identify to you 
all cheques that were adjusted that day. 
 

• Encoding errors over $20.00 require that the cheque is cleared for the correct dollar 
amount. These encoding errors should also be adjusted by 10 a.m. each business day. 
We will credit your business account for the incorrect dollar amount and debit your 
account with the correct dollar value of the cheque when/if it is re-cleared. Occasionally, 
an amount may be misread by the system rather than encoded incorrectly. In that case, 
there is no need for the 
cheque to be re-cleared. Instead, only the difference will be posted to your account. 

 
Note: If any encoding errors are missed by the system resulting in an ‘amount mismatch’ exception, 
please action the exception by selecting "Incorrect Amount" from the return dropdown list and then 
notify our Cash Management Support at 416 982-4567 or 1-800-668-7328, 8 a.m. – 8 p.m. ET 
(English), or 1-800-567-4455, 9–5 p.m. ET (French) to adjust the item and to ensure that you will not 
be charged for this exception. 

• All other exceptions will be presented to you through the exception management 
screens in CFP. These exception items do require your pay/no pay decision. We will 
send you a courtesy e-mail notification around 10 a.m. ET advising you whether or not 
you have any exceptions to manage as of that time (please see ‘Exception Processing’ 
section). If all exceptions have been decisioned prior to 10:00a.m. ET, the e-mail will 
report no exceptions. Weekly (Fridays) plus Month-end 

• If you miss the decision deadline and your cheque has been returned as per your default 
decision instruction, you will have to delete the item manually on the CFP Web, and 
reissue the cheque. 

 

Receiving Your Paid Cheque File Transmission 
 
As a Positive Pay customer, paid cheque information will need to be communicated from us to you via 
electronic transmission (if you choose to receive the optional Paid Cheque File). 

 
As with Issued Cheque File Transmission, pre-implementation set-up on both your company’s and 
TD’s system is required so that outbound transmission can take place. 
 

This section: 
 

• Details the processes involved in receiving CFP Paid Cheque files via Mainframe and/or 
Web Business Banking File Transfer Service. 

• Identifies the CFP PC File Name used for the Paid Cheque file when they are 
downloaded to your PC. 

• Provides the file formats for: 

• The CFP Paid Cheque file 
• The CFP NIL Paid Cheque file 

 
Both files listed above can be received through our Web Business Banking File Transfer Service or via 
mainframe computer. If you wish to receive a Paid EDI 821 file, please advise your Manager Business Banking 
Services who will provide you with the appropriate file layout. 
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Receiving Your CFP Paid Cheque File Using Web Business Banking 
 
The following is an overview of how to download your CFP Paid Cheque file from TD Commercial Banking 
using Web Business Banking. For complete instructions on how to download a CFP Paid Cheque File, 
please refer to the on-line help screens on TD Commercial Banking’s Web Business Banking site. 

 

Procedure: 

1. Log on to Web Business Banking. 

2. Select File Transfer option from the top horizontal menu bar to display the Receive file page. 

3. Select the option Cheque Fraud Protection Service from the Service drop-down menu. 

4. Click on the OK button located to the right of the Service drop-down to display the files that 
match your filter criteria. 

5. Select the file you wish to receive (CFP Paid File) by clicking the radio button to the left of 
the file. 

6. Click the Receive or Receive Zipped button to receive the file. A File Transport Service 
window will open to initiate the download followed by a Save File pop-up dialog. 

7. Specify the location and name of the file to save. 

Note: The Receive Zipped button allows you to receive the file in a compressed format, thus reducing the 
time required to download the file. 

8. Click on the Save button to begin the download. 

Note: Depending on your browser settings, the pop-up will either close automatically or you will have to 
click the Close button once the download is complete. 

9.  Close the File Transport Service Window to return to Web Business Banking. 

Optional CFP NIL Paid Cheque File 

You can choose to receive an optional NIL Paid Cheque file when there is no cheque activity for 
the selected period. 

CFP PC File Names 

All CFP files downloaded to your PC have a unique naming standard, identifying the date and time the 
file was created by TD Commercial Banking. 
 
To read the file names in the samples below, use the following table. 
 

Character Position Field Size Content Explanation 

1 1 Month A=Jan, B=Feb, C=March etc. 

2 1 Date A=1st, B=2nd, Z=26th, 1=27th, 2=28th, etc. 

3 1 Hour of day A=1am, B=2am, L=noon, P=4pm etc. 

4 - 5 2 Minutes 2-digit minutes (01 – 59) 

6 - 8 3 Seconds 3-digit seconds (00.00 – 59.9) 

 

Your CFP Paid Cheque file downloaded to your PC will have this unique naming standard, identifying 
the date and time the file was created by TD Commercial Banking. 

 

Example: a CFP Paid Cheque file with PC file name CJH08188.TXT would have been created on 

March 10
th 

at 8:08:18.8 a.m. 

C = March, J = 10
th

, H = 8 a.m., 08 = 8 minutes, 188 = 18.8 seconds 
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If you receive a NIL Paid Cheque file, the same naming convention is used as with your CFP 
Paid Cheque file. 
 

CFP Paid Cheque File Formats 

 
All CFP files must be formatted to TD Commercial Banking’s standard 80-byte output file formats. 
These standard layouts, which are detailed in this section, are the same regardless if you are receiving 
the file through Web Business Banking File Transfer Service or via mainframe 
 

CFP Paid Cheque File Formats 
 

Header Record: 

Position Description Type1 Length Sample Value 

1 Record Type A 1 Always H upper case 

2- 6 CFP Account Number N 5 95959 

7 - 11 TD Branch Transit N 5 10202 

12 - 18 CDA Account Number N 7 1234567 

19 - 48 CFP Account Name A/N 30 ABC Company Ltd 

49 - 56 File Date (yyyymmdd) N 8 20071231 

57 - 80 Reserved A/N 24 Filled spaces 

 

 Data Records: 

 

Subtotal Record2: 

 

 

Position Description Type Length Sample Value 

1 Record Type A 1 Always P upper case 

2 - 11 Serial Number N 10 0000012345 

          12 - 23 Amount N 12 
000000010000 

(=100.00) 

              24 - 31 
Paid Date 

(YYYYMMDD) 
N 8 20071231 

32 - 41 Item Trace No. N 10 0031242133 

42 - 50 Reserved A/N 9 Filled spaces 

51 - 75 Payee Name3 A/N 25 Roy Smith (see note) 

76 - 80 Reserved A/N 5 Filled spaces 

Position Description Type Length Sample Value 

1 Record Type A 1 Always S upper case 

2 - 10 
Sub Total Data 

Records 
N 9 000000001 

11 - 22 Sub Total Amount N 12 000000010000 (100.00) 

23 - 80 Reserved A/N 58 Filled spaces 
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Final Totals Trailer Record: 

 

1Valid Data Types: A = alpha characters (A –Z); N=numeric characters (0-9), A/N = alphanumeric                                                                                                                   

characters (A-Z; 0-9) 
2Sub-total Records: Only used for accounts using disbursement category option 
3This field will be filled with spaces for negative pay accounts and positive pay accounts not subscribing to 
the payee match option. In the payee match option, the Payee Name provided in the Issue File will be 
truncated to 25 characters and populated in the Payee Name field of the Paid File. 

 

CFP NIL Paid Cheque File Format 

Header Record: 

 

Data Records: 

Position Description Type
1

 Length Sample Value 

1 Record Type A 1 Always P upper case 

2 - 23 Forced Value N 22 9999999999999999999900 

24 - 31 Date (YYYYMMDD) N 8 20071231 

32 - 41 Forced Value N 10 9999999999 

42 - 50 Filled Spaces A/N 9 Filled spaces 

51 - 75 Forced Value A 25 NIL PAID FILE 

76 - 80 Reserved A/N 5 Filled spaces 

 

Trailer Record: 

Position Description Type
1

 Length Sample Value 

1 Record Type A 1 Always T upper case 

2 - 10 Total Data Records N 9 000000001 

11 - 22 Forced Value N 12 999999999900 

23 - 80 Reserved A/N 58 Filled spaces 

 

1Valid Data Types: A = alpha characters (A –Z); N=numeric characters (0-9), A/N = alphanumeric characters 
(A-Z; 0-9) 

 

Position Description Type Length Sample Value 

1 Record Type A 1 Always T upper case 

2 - 10 Total Data Records N 9 000000001 

11 - 22 Total Amount N 12 000000010000 (100.00) 

23 - 80 Reserved A/N 58 Filled spaces 

Position Description Type
1

 Length Sample Value 

1 Record Type A 1 Always H upper case 

2 - 6 CFP Account Number N 5 95959 

7 - 11 TD Branch Transit N 5 10202 

12 - 18 CDA Account Number N 7 1234567 

19 - 48 CFP Account Name A/N 30 ABC Company Ltd 

49 - 56 File Date (yyyymmdd) N 8 20071231 

57 - 80 Reserved A/N 24 Filled spaces 
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Outstanding Issue Cheque File 
 
You may also request to receive a monthly file of outstanding issued cheques. This file lists all CFP 
cheques on file that have not yet cleared your CFP account that have a status of outstanding. The 
Outstanding Issue Cheque file is available in our 80-byte file format which is outlined later in this guide 
and can be delivered to you either through Web Business Banking File Transfer Service or mainframe 
transmission. The file will be delivered to you on the first business day of the following month 
commencing at approximately 7:00 p.m. ET. 
 
Note that you can download an Outstanding Issued Report through the on-line CFP Service at any time if 
you require details of outstanding issued cheques. 
 

This section: 

• Details the processes involved in receiving CFP Outstanding Issue files by Mainframe 
and/or Web Business Banking File Transfer Service. 

• Identifies the CFP PC File Names used for Outstanding Issue Files 

• Provides formats for your CFP Outstanding Issued Cheque File 

Receiving Your CFP Outstanding Issue Cheque File Using Web Business Banking 
 
The following is an overview of how to download your CFP Outstanding Issue Cheque file from TD 
Commercial Banking using Web Business Banking. For complete instructions on how to download a CFP 
Outstanding Issue Cheque File, please refer to the on-line help screens on TD Commercial Banking’s Web 
Business Banking site. 
 

Procedure: 

1. Log on to Web Business Banking. 
 

2. Select File Transfer option from the top horizontal menu bar to display the Receive file page. 
 

3. Select the option Cheque Fraud Protection Service from the Service drop-down menu. 

 
4. Click on the OK button located to the right of the Service drop-down to display the files that  

match your filter criteria. 
 
5. Select the file you wish to receive (CFP Outstanding File) by clicking the radio button to the left 

of the file. 
 
6. Click the Receive or Receive Zipped button to receive the file. A File Transport Service window 

will open to initiate the download followed by a Save File pop-up dialog. 
 
7. Specify the location and name of the file to save. 

Note: The Receive Zipped button allows you to receive the file in a compressed format, thus reducing the 
time required to download the file. 

8. Click on the Save button to begin the download. 

Note: Depending on your browser settings, the pop-up will either close automatically or you will have to 
click the Close button once the download is complete. 

9. Close the File Transport Service Window to return to Web Business Banking. 
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CFP PC File Names 
 
All CFP files downloaded to your PC have a unique naming standard, identifying the date and time the file 
was created by TD Commercial Banking. 
 
To read the file names in the samples below, use the following table. 

 
Character 
Position 

Field Size Content Explanation 

1 1 Month A=Jan, B=Feb, C=March etc. 

2 1 Day A=1st, B=2nd, Z=26th, 1=27th, 2=28th, etc. 

3 1 Hour of day A=1am, B=2am, L=noon, P=4pm etc 

4 - 5 2 Minutes 2 digit minutes (01 – 59) 

6 - 8 3 Seconds 3 digit seconds (00.00 – 59.9) 
 
 

Your CFP Outstanding Issue file downloaded to your PC will have this unique naming standard, 
identifying the date and time the file was created by TD Commercial Banking. 
 
Example: a CFP Outstanding Issue file with PC file name CJH08188.TXT would have been created on 

March 10
th 

at 8:08:18.8 a.m. 
 

C = March, J = 10
th

, H = 8 a.m., 08 = 8 minutes, 188 = 18.8 seconds 
 

CFP Outstanding Issue File Formats 

All CFP files must be formatted to TD Commercial Banking’s standard 80-byte output file formats. These 

standard layouts, which are detailed in this section, are the same regardless if you are receiving the file 

through Web Business Banking File Transfer Service or via mainframe. 

Header Record: 

 

Position Description Type1
 Length Sample Value 

1 Record Type A 1 Always H upper case 

2 - 6 CFP Account Number N 5 95959 

7 - 11 TD Branch Transit N 5 10202 

12 - 18 CDA Account Number N 7 1234567 

19 - 48 CFP Account Name A/N 30 ABC Company Ltd 

49 - 56 File Date (yyyymmdd) N 8 20071231 

57 O/S Issue File Flag3 A 1 Always Y upper case 

58 - 80 Reserved A/N 23 Filled spaces 
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Data Records: 

 

Position Description Type1 Length Sample Value 

1 Record Type A 1 Always I upper case 

2-11 Serial Number N 10 12345 

12-23 Amount N 12 000000010000 (=100.00) 

24-31 
Issue Date 

(YYYYMMDD) 
N 8 20071231 

32 - 41 Item Trace No. N 10 31242133 

42 - 50 Reserved A/N 9 Filled spaces 

51 - 75 Payee Name4 A/N 25 Roy Smith 

76 - 80 Reserved A/N 5 Filled Spaces 
 

Subtotal Record2: 

Position Description Type
1

 Length Sample Value 

1 Record Type A 1 Always S upper case 

2 - 10 
Sub Total Data 

Records 
N 9 000000001 

11 - 22 Sub Total Amount N 12 000000010000 (100.00) 

23 - 80 Reserved A/N 58 Filled spaces 

 

Final Totals Trailer Record: 

Position Description Type
1

 Length Sample Value 

1 Record Type A 1 Always T upper case 

2 - 10 Total Data Records N 9 000000001 

11 - 22 Total Amount N 12 000000010000 (100.00) 

23 - 80 Reserved A/N 58 Filled spaces 
 

1Valid Data Types: A = alpha characters (A –Z); N=numeric characters (0-9), A/N = alphanumeric 
characters (A-Z; 0-9) 
2Sub-total Records: Only used for accounts using disbursement category option 
3This indicator is used to distinguish the outstanding file from a CFP Paid file that may be 
transmitted to the same communications mailbox 
4This field will be filled with spaces for positive pay accounts not subscribing to the payee match 
option. In the payee match option, the Payee Name provided in the Issue File will be truncated to 
25 characters and populated in the Payee Name field of the Outstanding Issue File. 
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Cheque Fraud Protection Service - On-line Service 

System Administrators 
 

Logging into the CFP Service 

To ensure the security of the CFP Service, all Users are required to identify themselves with a User Name 
and Password. CFP associates each User with a role or roles. 
 
To access the CFP Service: 

• Using your assigned Web Business Banking Connect ID and password, log into Web 
Business Banking via the following URL: 

https://businessbanking.tdcommercialbanking.com 

• Select Cheque Fraud Protection from the services drop down menu located in the top 
right-hand corner of the webpage. 

• Once directed to the CFP Service, you will be required to enter the User Name and 
Temporary password provided to you by your Implementation Manager. 

 

 
 
 
 
 
 
Note: If you try to log in without entering a User Name or Password, or you have entered an invalid User 
Name or Password, the system will display an error message. 
 

If you have forgotten your User name or Password or have not been issued a User name or Password, please 
contact your TD Implementation Manager. Following your Implementation, please contact our Cash 
Management Support for assistance with your Username and/or password. 
 
Note: If you attempt to log in to the system with an incorrect password more than three times, your account 
will be locked. Please contact your TD Implementation Manager to unlock your account. 

Following your Implementation, please contact our Cash Management Support for assistance with your 
Username and/or password. 
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• The first time you log into CFP Service, you will be prompted to change your password. 
Make sure that you follow these guidelines when creating your password (password is 
case sensitive, minimum length of 7 characters with maximum of 30, alphanumeric, must 
contain at least one of each of the following classes – upper case letters, lower case 
letters and numerals). 

 
• Once your password has been changed successfully, the CFP Service will display a 

confirmation message. Click continue to be directed to the CFP home page. 

 

Adding a New User 

• From the home page, click on the manage users icon. 

• Two options will be displayed, select the Add User option. 

 

• The user management page will be displayed 
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• Enter the User’s details as follows: 

 
Create a User name for the employee. A User name must be unique, so it is 
suggested that you use the first 7 characters of your company name followed by 
the first 5 characters of the employee’s last name (or less if the employee’s last 
name is less than 5 characters) i.e. Company Name – ABC Company,  
 
Employee – Jane Smith – suggested User name would be abccomsmith 
Employee – Jane Lee – suggested User name would be abccolee 

 
Note the following when creating the User name (not case sensitive, alphanumeric and minimum length 5 
characters with maximum of 12). 
 
• First and Last Name – Enter the user’s first and last name in these fields. 

• Role(s) – Assign one or more roles to the User according to the following rights model. A list of all 
available rights will be displayed under the Unselected column. Select the appropriate Role Types for the 
User and move them to the Selected column using the arrow keys: 

 
 

  

 

 

  

 

 

 

 

 

 

 

Users cannot be deleted, they can only be made ‘Inactive’. Once inactive they can no longer access the 
system. Only the company administrator can switch a User’s status back to ‘Active’. If you set a User to 
‘Inactive’ status and that User is also designated to receive notification e-mails, please notify your TD 
Manager, Cash Management, so that we can update our records. 

 
• For account selection, a list of your company’s available CFP accounts will be displayed 

under the Unselected column. Select the accounts that the User will have access to and 
move them to the Selected column using the arrow keys. 

• Position Title – Enter the User’s position within your company. 

• E-mail – Enter the User’s e-mail address. 

• Phone and Fax Numbers – Enter the User’s telephone and fax numbers in these fields. 

• Status – The User’s account status is automatically set to “Reset Password’ when a new 
User is added. Once the User has logged in and changed their password, the status will 
automatically change to ‘Active’. 

• Language – Select the User’s language preference using the drop-down box. This 
preference will determine whether English or French will be presented to the user upon 
logging into the CFP Service. 

Role Type Rights 

View 
User can search for paid, issued, stopped, voided or deleted 
records, download reports and view exceptions items 

Process 
User can process exceptions, return paid, items, view stops, voids 
and deletes. User can generate reports and search items 

Change User 

User can delete issue records and issue 
files, lodge stop payments, delete stop payments and voids. 
User can generate reports and search items 
User can view exceptions 

Upload 
User can upload manual cheque issued 
records 

Administrator 
User can create and manage company. Users by resetting 
passwords and changing a User’s status. 
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• When all of the User account data is entered, click on the next button at the bottom of the 
page. The CFP Service will display the Review tab for you to confirm all of the User 
information. Note that the User Temporary Password will be displayed here. Copy the 
Username and password down so that you can pass the information to the User. 

• If the information is correct, press the submit button. Otherwise, press the previous button 
to return to the previous screen and make the desired corrections. 

• Provide the User with both their User name and Temporary Password separately.  

As System Administrator, you will be able to reset User passwords should a User become 
“locked” out of the CFP Service. This can happen if a User forgets their password and 
attempts several times to enter an incorrect password. As you may be out of the office from 
time to time, a back-up System Administrator should be assigned to ensure that your company 
can always manage Users. The back-up System Administrator can also reset your password if 
you become “locked” out of the CFP Service. 

Note that your company is accountable for all actions associated with User names and Passwords, so it 
is important to protect the confidentiality of this information at all times. 

 

Search/Review/Edit Existing Users 

• From the Manage Users page, enter all or part of the User name you wish to search for and 
click the search button. 

• The User Search Results page will be displayed. An ‘icon’ legend is displayed on the 
bottom right section of the page. 

• Click on the page icon to view the User’s audit trail. 

• If you wish to edit the User, click on the pencil icon. You will be able to edit all of the User’s 
information except for their User name and password. 

Delete Users 

• System Administrator is authorized to delete existing user. 

• From the home page, click on the manage user's icon. 

• From the Manage Users page, enter all or part of the Username you want to update and 
click the search button. 

• The User Search Results page will be displayed. Under the column Edit User, click on the 
pencil icon. 

• In the status field, change the status in the drop-down list to “Deleted”. Click next. 

• To delete a user the System Administrator should choose "Deleted" option from the user 
page. 
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• Click ‘Next’ to review the changes. When you are satisfied with the changes, click ‘Submit’. 
 
 
 
 
 
 
 
 
 
 
• System displays a message that user was successfully updated. User status is now marked as 

"Deleted". 
 

 
 

Note: Once a user is deleted 

• Deleted user id can no longer be used to log-in to the application 
• Deleted user id cannot be re-used 
• Deleted user id, once updated with a deleted status, cannot be reverted back to any other status 

available nor any other information can be updated for this user id 
 

Reset User Password 

• If a User should become ‘locked out’ of the CFP service, as the System Administrator, you 
can reset the User’s status from ‘Locked’ to ‘Active’ without changing their password. 
Usually though, it will be necessary to reset the User’s password because the reason 
they’ve been ‘locked out’ is that they’ve forgotten their password. To do this, you will 
change the User’s status from “Locked” to “Reset Password”. 

• From the home page, click on the manage users icon. 

• From the Manage Users page, enter all or part of the Username you want to update and 
click the search button. 

• The User Search Results page will be displayed. Under the column Edit User, click on the 
pencil icon. 

• In the status field, change the status in the drop-down list to “Reset Password”. Click next. 

• In the password field, a new Temporary Password will be displayed. Copy the Temporary 
Password so that you can pass the information to the User. 

• Click on the submit button. The User’s account status is automatically set to “Reset 
Password’. When the User enters the Temporary Password, they will be prompted to enter 
a new password. Once the password has been updated, the User’s status will automatically 
change to ‘Active’. 

 

 

 



 

30 
 

CFP Users 
 

Logging into the CFP Service 
 
To ensure the security of the CFP Service, all Users are required to identify themselves with a User Name 
and Password. CFP associates each User with a role or roles. 
 
To access the CFP Service: 

 
• Using your assigned Web Business Banking Connect ID and password, log into Web 

Business Banking via the following URL: 

 
https://businessbanking.tdcommercialbanking.com 

 
• Select Cheque Fraud Protection from the services drop down menu located in the top right-

hand corner of the webpage. 

• Once directed to the CFP Service, you will be required to enter the User Name and 
Temporary password provided to you by your Company’s System Administrator. 

 
 
 
 
 
 
 
 
 

 
Note: If you try to log in without entering a User Name or Password, or you have entered an invalid 
User Name or Password, the system will display an error message. 

 

 
 

If you have forgotten your User name or Password, or have not been issued a User name or 
Password, please contact your Company System Administrator. 
 
If you attempt to log in to the system with an incorrect password more than three times, your account will 
be locked. Please contact your Company System Administrator to have your password reset. 
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• The first time you log into CFP Service, you will be prompted to change your password. 
Make sure that you follow these guidelines when creating your password (password is case 
sensitive, minimum length of 7 characters with maximum of 30, alphanumeric, must contain 
at least one of each of the following classes – upper case letters, lower case letters and 
numerals). 

 

 

 

 

 

 

 

• Once your password has been changed successfully, the CFP Service will display a 
confirmation message. Click continue to be directed to the home page. 

 

Navigation through The CFP Service 
 
Once you have logged into the CFP Service and depending on what User rights are assigned to you, you 
will be presented with a number of icons on your User homepage 

 

 
 

 
 
You can also navigate through the CFP Service by clicking on any link in the navigation menu: 

 

 
 
Links and Buttons 

A link is a connection between two web pages and will be highlighted when you move your mouse 
pointer over it. When you click on a link, the displayed page will be replaced with the linked page. Links 
are also used to jump between sections on a single page. 

Buttons are graphics that when clicked, initiate a system function such as search. 
 
Clear This Page 

When you click the Clear this Page button, all of the information entered on the page will be cleared. The 
page will refresh to the default values. 

 
Paging 

Only one page of a list may be displayed at a time. If a list is comprised of more than one page, the 
application will display a navigation control block at the bottom of the page. The navigation controls may 
be used to page through the list either by moving: 
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• Forward or backwards one page at a time using the  or  link, 

• To the first or last page by selecting the  or  link or 

• Directly to a specific numbered page by entering the number in the field provided and 
hitting the enter key on your keyboard. 

 

 
 
 
System Error Messages 

The CFP Service will notify you if an activity was unsuccessful. The following screen shows the error 
message generated by an unsuccessful login attempt: 

 

 
 
Error messages appear in the following situations: 
 
1) Invalid information 

 
If information in one or more fields is incomplete or has been entered in an unrecognized format, 
you will be prompted to modify the data. This will occur at logon if you enter an incorrect user 
name or password or fail to enter either of these. Another example of invalid information is alpha 
characters in the amount field when performing a search. 

 

2)   Empty mandatory fields 
 
If you submit a form without entering the required information, the system will display a 
message that indicates information is missing. 

 

Issued File Search 

 
When you send a CFP Issued Cheque File transmission to us, we will send you an e-mail advice within 
approximately one hour to advise you that we have processed your file. If we reject an issued cheque, we 
will instruct you to access the on-line Issue File Search screens for details. 

 
• To view your Issued Cheque File results, click on the search 

icon from your home page.  
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• Click on the Issued Files Search tab from the search screen. 

 
• Select an account(s) from the drop-down box. 

• In the Search By field, select either the File Date (field populated in the transmitted file) or 
the file Reference # (provided on the confirmation page when issues are added online) as 
your search criteria. 

• To enter the date, enter your settings either from the drop down boxes or from the calendar 
icons. 

Note that you should be searching on date based on the date in the header record of your 
Issued Cheque File. 

• Click on search to perform the search. 

• The Issued File Search Results screen will display counts and statuses for each item 
contained within your Issued Cheque File submission. 

 
 
 
 
 
 
 
 
 
 

 

• If you search for an Issued Cheque File submission following receipt of your e-mail advice, 
you should see all items showing with a status of outstanding (unless any items were 
rejected or you submitted void or stop records) 

• If your entire file rejected, the word rejected will appear on the issued file search results. 
Rejected items will display the reason for the rejection. 

• If you were to search for an Issued Cheque File several days following submission, you 
would be able to see which items within that file transmission are still outstanding, which 
items have since been paid and if you changed the status of any records to void or delete, 
those statuses would be reflected within this search result. 
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• Note that if you submit an Issued Cheque File containing a Void or Stop record, when you 
search for your Issued Cheque File results, that record will not display under the current file 
search results but will match against the original issued cheque record on the date you 
submitted the original record. 

• If you transmit a void in the same file as the original issue, the issue record must precede 
the void record in the file. If the void record comes first in the issue file, the void record will 
be rejected. The records are processed in the order in which they are presented in the file. 

• You can delete an issued file from this screen as a Change user, by selecting the tick box 
located beside the Outstanding status (Note: only outstanding issue records can be 
deleted. Records that are already paid cannot be deleted): 

 

 
 
 
 
 
 
• You can view a list of specific items within the search results by clicking on the icon in the 

count field . A list of items will appear in a separate window: 

 

• After clicking on the count icon, the new window will display the details of the items matching that group 
of Issued Cheque records. You can view, print or download the list of items by selecting generate report 
(see Generate a Report in a subsequent section). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Manual Upload of an Issued Cheque Record 

 
To manually add an Issued Cheque Record, you must have Upload access rights. 
 

• From your home page, click on the uploads icon. 
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• You will be re-directed to the Add Issued Record tab. 

 
 
 
 
 

 
 
 
 
 
 
 
• Select the account you wish to upload records to from the account drop down box. 

• Enter the Serial #, Issued Date, Issued Amount and Payee name for the Issued Cheque 
record. 

• To create additional records, click on the + sign. To remove a record, click on the – sign. To 
start over at any time, click on the clear this page button. Please note that you can add up 
to 10 Issued Cheque records per issued record upload. 

• Once you have completed entering all of your records, click on the upload record button. 

• From the Review Actions page, verify that you have entered all of the information correctly. 
If you subscribe to the Payee Match Service, ensure that you have entered the payee name 
exactly as it appears on the cheques to avoid any unnecessary exceptions. 

 
 
 
 
 
 
 
 
 
 
 

• If you need to make any corrections, you can click on the back to upload button to make 
the updates. If you are ready to submit your manual Issued Cheque records, click on the 
submit button. You will receive a confirmation page confirming acceptance of the issued 
record upload. 

 
 
 
 
 
 
 
 
 
 
 
 

• Within an hour of having uploaded issues online, we will send you a bilingual Consolidated 
Issue(s) Added On-Line Notification E-Mail which will advise designated e-mail addresses 
that issues have been added successfully on-line via the CFP Web.  
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Following is a sample of the E- Mail: 

 
 

Search for a Paid Cheque 

To perform a search to determine if a particular cheque has been paid, click on the search icon on your 

home page.  

• From the Paid Search screen, select the Paid Search tab.  

• Select an account from the account drop-down box. 

You may select one account using the “>” or “<” buttons to move your selection from the ‘Unselected’ box to 

the ‘Selected’ box. 
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You may select multiple accounts by holding the CTRL key while mouse clicking on the selected accounts.  

Click on the “>” “<” buttons to move your selection from the ‘Unselected’ box to the ‘Selected’ box. 

    

 

 
 
 
 
 
 
 
 
 
 
 
You may select all accounts using the ">>" or "<<" button to move your selection from the 'Unselected' box 
to the 'Selected' box. 

 

 
 

For a paid item search, you will need to specify search criteria as follows: 

• You may search for an individual serial number by entering that serial number in both the 
Serial number range from: and To: fields. If you want to search on a range of serial 
numbers, enter the beginning serial number in the Serial number range from: field and 
the ending serial number in the To: field. 

• If you are searching for a specific amount, enter that amount in both the Amount range 
from: and To: fields. You may also search for a dollar range by entering the lower dollar 
value in the Serial number range from: field and the higher dollar value in the To: field. 

• You must enter a start of search date in the Date range from: field. You may enter an end 
of search date in the To: field. Note: the To: field will default to the current date. 

• You may filter your search results on specific statuses. To do so, select the status(es) you 
want to include in your results in the Unselected: column, then click the “>” button to move 
them to the Selected column. Click “>>” to move all statuses to the Selected column. If you 
change your mind, you may select the status and move it back to the Unselected: column 
using the “<” button or click on the “<<” button to move all statuses back to the Unselected: 
column. 
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• When you have finished entering your search criteria, click on search to perform the 
search. If you want to clear all of your criteria and start over, click on clear. 

The Paid Search results screen will be displayed: 
 

 
 

View an Image of a Paid Cheque 

After performing a search for a paid cheque, you can view an image of the cheque by clicking on the cheque 

serial number hyperlink. The CFP Service retains 7 years of cheque images. If you subscribe to the DVD ROM 

service, please see the Cheque Image Archive – DVD Rom Service section of this guide for more 

information. 
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• A popup window will be displayed with an image of the cheque as well as relevant cheque 
details. The paid details show the serial number and amount that was captured from the 
MICR line of the cheque as well as the date it was captured. To view the reverse of the 
cheque, click on the view reverse button. 

 

 
 

To close the window, click on the close button. 

 
 

No Image Available 

After performing a search for a paid cheque image, you may get the following instead of an image: 

 
 

If the Paid Search Results screen displays an ‘S’ in the ‘?’ column then this cheque was posted as a sundry 

item. A sundry item (manually posted directly to your business account) does not have an image in the CFP 

system because it does not pass through the automated capture process.  This can happen if the cheque 

was presented torn or folded, or if there is something wrong with the MICR line.  Sundry items are manually 

matched on the day following presentment and the decision deadline is the day following the manual posting 

(2:00pm local time for CAD items and 12:00pm EST for USD items).  If you are noticing a high volume of 

sundry items, please speak with Cash Management Support regarding having your cheques’ MICR line 

tested. 

View the Audit Trail for an item 
 
• From any search results screen, you can view the audit history for any item by clicking on 

the memo icon located in the detail column. 

• A popup window will be displayed. From this window, you can print the audit details by 
clicking on the print button.  
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• To close the window, click the X in the top right-hand corner. 

 

Add a Memo  

From any search results screen, you can add a memo (or memos) about a particular item by clicking on the 

memo icon located in the detail column. 

 
• You must have process or change access in order to lodge a memo. By clicking in the 

Add Memo field, enter the details.  

 

 

 
• Close the window by clicking on the X in the top right-hand corner.  

• If you want to add an additional memo, click on the add memo button and a new box will 
appear for the new message. 
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Search for an Issued, Stopped, Voided or Deleted Cheque Record 
 

• After clicking on the Search icon from the home page, select the Issued Search tab. 
Outstanding, Stopped or Voided records are retained indefinitely within the CFP Service. 
Deleted records are retained for a period of 90 days. 

 

• Select an account(s) from the account drop-down box. For an Issued, Stopped, Voided or 
Deleted record search, you will need to specify search criteria as follows: 

• You may search for an individual serial number by entering that serial number in both the 
Serial number range from: and To: fields. If you want to search on a range of serial 
numbers, enter the ending serial number in the To: field. 

• If you are searching for a specific amount, enter that amount in both the Amount range 
from: and To: fields. You may also search for a dollar range by entering the higher dollar 
value in the To: field. 

• You must enter a start of search date in the Date range from: field. You may enter an end 
of search date in the To: field. Note: the To: field will default to the current date. 

• When you have finished entering your search criteria, click on search to perform the 
search. If you want to clear all of your criteria and start over, click on clear. 

• The Issued Search results screen will be displayed: 
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Lodging a Stop Payment, Voiding or Deleting an Issued Cheque Record 

As a Change user, after performing a search for an Issued Cheque record, you can change the status of an 

outstanding issued record to a Stop, Void or Delete by selecting the appropriate status from the status drop 

down list. 

 

• If you wish to change the status of the entire group of search results, this can be achieved 
by selecting the Change All drop down. 

• Please note that a Void will remain on the CFP Service indefinitely and the cheque serial 
number may not be reused. If you need to re-issue the cheque serial number, choose the 
delete option. You may need to use the delete option in situations where the record was 
uploaded with an incorrect amount. You would delete the original record and then upload a 
new record with the same cheque serial number and corrected amount through the Upload 
function. 

• Once you have made your update in the drop down box, click on review button. 

 

• Review your request. To return to the search page, click on the back to search results 
button. If you wish to complete the request, click on submit. 

• The confirmed changes page will display confirming the status changes you have made. 

• If you place a stop payment on a cheque but need to remove the stop payment, you would 
search for the stopped record, delete it, and then upload a new Issued Cheque record 
through the upload function. 

• Please note (as per the disclaimer) that you must ensure that the cheque has not already 
been paid before placing a stop payment record. 

Exception Processing 

Please note that for the Payee Match Service, you send us either 25 or 40 characters of the payee name in 

your Issued Cheque File (depending on which Issued Cheque file layout you are using). We verify the first 25 

(or 40) characters of the payee name that appears on the first payee line on the cheques against the 25 (or 

40) characters you provided to us in your Issued Cheque file. If the word “and” or “or” or the ampersand 

symbol appears following the first 25 (or 40) characters on the first payee line, we will automatically present 

the cheque to you as an exception for your pay/no pay decision. We have no way to verify that a name has 

been added to the payee line and therefore require your decision. 
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If your issue file payee name contains 10 characters and your cheque’s payee name contains 11 characters, 

the cheque will be presented as an exception. The following are some examples of when exceptions can 

occur: 

Condition 
Cheque Payee Name (First 

Line) 
Issue File Payee Name 

The cheque’s payee name is 
separated into two lines on your 

cheque 

John Bailey 
ABC Corp           

John Bailey ABC Corp 

There is a number/character/word 
preceding or following the cheque’s 
payee name (on the first line only) 
which does not appear in the issue 

file 

John Smith (8) 
or 

023456789 
John Smith 

John Smith 

You subscribe to a 25- or 40-
character payee name for the issue 
file and your issue file payee name 

contains fewer than 25 or 40 
characters, respectively, but the 

cheque’s payee name contains more 
than 25 or 40 characters 

John Bailey Smith Incorporated  
30 characters including spaces       

John Bailey Smith  
18 characters including 

spaces 

Reversed payee names Smith, John       John Smith 

The word “and”, “or” or the 
ampersand symbol appears in the 
cheque’s payee name following the 
first 25 or 40 characters on the first 

payee line 

ABC Widget Company Limited 
and John Smith 

ABC Widget Company 
Limited 

(25 characters) 

 

Please note that we will automatically action the following exception types and not present them as 

exceptions: 

• Paid Against Stop 

• Amount Discrepancy/Encoding Errors 

• Serial Number Misreads 

If by chance you are presented with an exception that is determined to be an amount discrepancy or a serial 

number misread, please contact our Cash Management Support immediately for instructions on decisioning 

the exception. 

If you receive an exception and no image is available, please contact our Cash Management Support to 

obtain a manual faxed copy of the image. If your exception deadline is approaching, you can make an initial 

Pay decision for the exception cheque. Once you have the copy of the cheque for reference, and if you 

determine that the cheque should not be paid, you can request the return of that cheque by following the 

steps outlined in the Request a Return of a Paid Cheque section of this guide. 

We will send you a courtesy bilingual Exception and Returns Notification e-mail around 10 a.m. ET each day 

to advise you of one of more of the following: 

• You have no exception cheques to decision (if your account is subscribed for a ‘null’ 
notification) 
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• You have exception cheques that require your pay/no pay decision  

• The e-mail reports on the status of the exceptions at the time the e-mail is sent. So, if 
you or another user have made decisions on all exception items prior to our sending of 
the e-mail, the e-mail content will advise that there are no exceptions to decision 

• You have cheques that were returned since the last e-mail notification 

• You have cheques that were not able to be returned since the last e-mail notification 

• You may have made a return decision the previous day which we could not fulfill 
because either recourse was lost or the item’s amount had been misread by the system 
so only needed to be adjusted and not returned.  

Designated users will receive a consolidated e-mail per company profile, including all positive 
pay accounts that require reporting and for which that user has been designated to receive a 
notification.   

Please ensure that you have advised us of the individual or individuals that need to receive this 
e-mail notification. We recommend that you provide a group e-mail address so that in case one 
individual is out of the office, the notification will be received by other individuals who can make 
the required pay or no pay decisions. It is very important that your company manage exceptions 
by the required deadline to ensure that cheques that should be paid are not returned by your 
default decision. 

Sample e-mail notification for an e-mail address that is designated to receive null notification for 
account 9997 and positive notification for account 9998:   
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• From your home page, if you are a Process, Change or View user, you will have the 
exceptions icon displayed. If you have exceptions to manage, the icon will appear in red 
and be marked “current exceptions”. Only Process Users can make pay/no pay 
decisions on exception cheques. View Users can view exceptions only 
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• If you have no exceptions to manage, the icon will appear in blue and be marked 
“exceptions”. 

 

 

• From the Exception Processing screen, you can view all presented exceptions for your 
assigned accounts. You can choose to review exceptions for one account or for all of your 
accounts by selecting your choice from the Account drop down list. 

 

• From this screen, you can view an image of the exception cheque, the reason for the 
exception, the Issued Date, the Paid Date and the Paid Amount.  You will also be advised 
of the Due Date and Time as well as your Default choice for your decision.   The deadline 
for Canadian dollar cheques is 2 p.m. local time and the deadline for U.S. Dollar cheques is 
12:00 p.m. ET. 

• Process Users will be presented with two radio buttons for Pay or Return decisions. Click 
the appropriate pay/no pay decision and the reason for return from the drop-down list of 
available return reasons. 

• If you fail to respond by the deadline, your default decision will be applied. If your default 
decision is return and you do not respond by the deadline, the exception cheque will be 
returned as “payment stopped”. (If this occurs and you wish to reissue the same serial 
number, you must delete the issue record and reissue the item.) 

• To complete your decision, click on the review button. 

• You will be presented with a review page showing you a list of all of your processing 
decisions grouped by decision type. Click on submit to submit your final decisions. 

 

Request the Return of a Paid Cheque 

If you make a pay decision on a particular exception cheque or determine that a paid cheque should be 

returned, you can request the return of a cheque through the on-line CFP Service. 

• To request the return of a cheque you do not want paid, perform a paid item search as a 
Process user to locate the paid record. 
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• View an image of the cheque (if required). 

 

 

Select the reason for the cheque to be returned from the drop-down Return Code list. It is 
important to return a cheque for the correct reason. It is your responsibility to select the 
correct reason for return. If you fail to do so, the encashing bank may dispute the returned 
cheque and recourse could be lost. This could mean a loss to your company. Please review 
the Return Codes and the guidance below carefully and select the appropriate reason for 
return. Please note that only applicable reasons for return will be displayed that meet 
recourse timelines. For example, if the issue date on the cheque is one month from the paid 
(presentment) date, you would not be able to request that a paid cheque be returned as 
stale-dated.  

The full Return Code list follows: 

Return Code Select this Return Code when: 

Counterfeit 
A cheque that appears to be original or genuine, but has been 

fraudulently made 

Duplicate 

A cheque that has been paid more than once. For example, a 
cheque deposited using remote deposit capture (using the cheque 
image) and then the physical cheque was deposited and both the 

original and image were paid. 

Forged Endorsement 

"Endorsement" means a signature made by a payee/holder of a 
cheque on the back of the cheque when negotiating (transferring) it 

to another person. 
A "Forged Endorsement" means an Endorsement in the name of the 

payee that has been forged. Not endorsed by payee. 
Does not include an endorsement where the payee name has been 

altered on the front of the cheque without authorization. 

Incorrect Amount 

The amount on the cheque is accurate but the cheque has been 
cleared for an incorrect amount (the amount written in figures on the 

face of the cheque does not match the MICR encoded amount). 
Does not include cheques where the amount (sum payable) of the 
cheque has been changed without the authorization of the drawer. 
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Return Code Select this Return Code when: 

Intended Payee Not Paid 

The named and intended payee of a cheque did not receive 
the funds.  

Does not include cheques where the payee name has been 
altered on the front of the cheque without authorization. 

Item Cleared in Wrong Currency An Item cleared in the wrong currency. 

Material Alteration – Amount 
The amount (sum payable) of the cheque has been changed 

without the authorization of the drawer. 

Material Alteration – Payee Name 
The payee (drawee) name has been altered on the face of the 

cheque without authorization. 

Payment Stopped 
If you wish to stop payment on a cheque before it is presented 

for payment. 

Post Dated 
A cheque may be returned “post-dated” up to and including the 

day prior to the due date. 

Signature Illegible Drawer signature is not legible 

Signature Required Drawer signature is missing 

Signature Unauthorized 

A signature on the face of the cheque that is forged or 
unauthorized (not the signature of the authorized person/ 

drawer) 

Stale Dated 

A customer may return a cheque that is dated more than six 
months earlier. 

Does not apply to bank drafts, money orders or certified 
cheques. 

Words and Figures Differ 
The amount written in words on the face of the cheque is 

different than the amount written in figures. 

 

• When you have completed processing your exceptions, click on the review button at the bottom of the 
page. 

• A review page will be displayed showing you a listing of all your processing decisions, grouped by 
decision type. Items designated for return will show in "return pending" status until the Exception 
Cheque has been physically returned. Cheques are returned between 4 and 5pm, local time daily. 

• To return back to the Exceptions Page, click the back to exceptions button at the bottom of the page 
and make further decisions (including changes to decisions made in the current online session). 

• Click on the submit button to finalize your request. 

• Note that any undecisioned cheques at the decision deadline will have your default pay/no pay 
decision applied to them automatically. 
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Declaration Requirement 

Important Note: If you wish to return a cheque for the reason Material Altered, Forged Endorsement, or 

Intended Payee Not Paid later than 48 hours after the cheque has been paid, you will be required to 

complete a declaration form. Instructions, fax numbers and addresses are provided within the CFP Web. The 

faxed Declaration form MUST be received by the CFP Department no later than 2:00 p.m. local time on the 

date you request the return of the cheque or the item WILL NOT be returned.  This fax must be followed by a 

mailed or couriered original executed Declaration. (For U.S. Dollar accounts clearing through TD New York, 

the declaration is required if the cheque is returned for the noted reasons later than 24 hours after the 

cheque has been paid and you will be prompted to execute a declaration when requesting the return.) 

Returning a Counterfeit vs. Materially Altered Item 

It is important to return a cheque for the correct reason as counterfeit cheques must be returned within one 

business day of the paid date.  If an item is Counterfeit and is returned for the reason Materially Altered, the 

encashing bank may dispute the returned cheque and recourse could be lost. This could mean a loss to your 

company.  To determine whether a cheque is truly Counterfeit, print the exception cheque, front and back, 

as well as some copies of ‘good’ cheques.  Compare all the details on the front of the cheque as well as 

security features on the back and front.  If anything on the exception does not match the good cheque, then it 

may be counterfeit. 

Generate a Report 

From your home page, click on the reports icon 

 

• From the Generate Report screen, select the account number from the Account 
dropdown list. 

• Select a report to download from the Report Type dropdown list. 
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• Enter the date range for the report and click on generate report. The date range cannot 
exceed 365 days. 

 
When generate report is selected, a message at the top of the page will appear informing you that the 

report will be available under the Report Retrieval tab.  The message will provide you with a request 

number (specific to you) that will identify your report request on the Report Retrieval page. 
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You can view the desired report by selecting the file name link from the Report Retrieval page.  A Microsoft 

Excel file download command will appear allowing you the flexibility to open and view immediately, to save to 

a separate drive, or to cancel and end the job. 

 

The All or Multiple link displays a list of CFP accounts if more than one account was selected during report 

generation. 

 

The report will be available from the Report Retrieval tab for four days, (exclusive of weekends, but 

inclusive of National and Regional holidays). A file name will be generated. If the report is very large (over 

50,000 records) it will be divided into multiple Excel files.   

You may use the Refresh button from the Report Retrieval page to view the current status of a report. 
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A sample Paid Report follows: 

 
 

CFP offers a variety of reports for download for Positive Pay customers as follows: 
 

Report Name Description 

Outstanding Issued 
Lists all cheques in the system which have a status of outstanding as of the 
selected date. This includes postdated items as well 

Outstanding Stops and 
Voids 

Lists all cheques which have a status of stop or void as of the selected 
date. Positive Pay customers would only receive an outstanding stops 
report 

Paid Lists all cheques which have been paid during the selected date range 

Adjustments 
Provides you with a listing of cheques that were adjusted during the 
selected date range 

Return 
Provides you with a listing of cheques that have been returned during the 
selected date range 

Deleted 
Lists all Issued Items which have a status of deleted during the selected 
date range 

Item Trace List 
Provides a listing of cheques paid as well as any manually posted items on 
a certain date. The report does not include returned items and should not 
be compared to the CFP List Total posted to your business account. 

Paid Reconciliation 
Summary 

Contains the accumulated total count and amount of cheques processed by 
the CFP Service, which have been posted to your CDA (business) account, 
as well as any adjustments, corrections and returns processed to your CDA 
account and the CFP Service within the defined date range 

Paid Reconciliation Details 
Provides a breakdown of the transactions from the Paid Reconciliation 
Summary report. 
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Report Name Description 

Issue Reconciliation 
Summary 

Contains the accumulated total of all transactions processed by the CFP 
Service associated with the issued cheques, and any unmatched records 
remaining outstanding for a CFP positive pay account within the defined 
date range. 

Issue Reconciliation 
Details 

Contains the breakdown of the transactions from the Issued Summary 
report. 

Exception Report  Lists all exceptions presented for decisioning over a period 

Serial Corrected Positive 
Pay Report 

 Identifies all items that have had a serial number    corrected. 

Item Audit Log Report 
Captures details of actions performed by a user for specific a date range 
on an item. 

User Account Audit Log 
Report 

Provides audit trail of changes to an Account OR User profile. Report 
includes the details of changes made (old and new data) as well as the 
user information of the person making the change. 

Note: Assists in adhering to internal audit requirements. 

User Access and Rights 
Report 

Provides user details of assigned accounts and the associated 
permissions.  

Reconciling your account 

You may elect to receive our optional reconciliation service. 
 

Reconciliation Frequency Options 

Under the CFP Service, reconciliation is available for the following frequencies: 

• Monthly 

• Weekly 

• Bi-weekly 

• Daily 

• Weekly plus month-end 

CFP Back-up Package 
 
If you receive our optional Reconciliation Service, your reconciliation reports, and bank statements (your 
back-up package) are provided to you within seven to ten business days following either month end or 
your requested period-end. You can elect to receive your back-up package through one of the following 
delivery channels: 
 
• Courier - you provide us with your courier name and account numbers 

• Canada Post 

• Via a designated TD Branch for pickup 

 

Self-Reconciliation 

If you would like to perform reconciliation on your own by downloading the reconciliation reports from 
the CFP Web, please select the Help link at the bottom of any CFP Web screen which will take you to our 
new Self-Reconciliation Guide. The Guide will explain the reconciliation reports. 
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Broadcast Messaging 
 
If we need to provide you with important information regarding our CFP Service we will do so using 
our Broadcast Messaging feature. We will post a message on your home page beneath the icons. For 

example: 

 

Marketing Messaging 
 
If we would like to suggest another complementary product offering, we may do so by displaying one or 
two clickable image on the login page. For example: 
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Cheque Image Archive – DVD Rom Service 
 
Cheque Fraud Protection Service provides archived cheque images on DVD ROM. You can access 7 
years of cheque images through the on-line service. If you require additional backup of images, you 
may need to subscribe to our DVD Rom service. 
 

Introducing CheckVision 

 
The Cheque Image Archive - DVD ROM Service provides the ability to retrieve, view and print 
cheque images of processed items. 

 
The viewer used on the DVD ROM is a readily available product called CSC CheckVision. Using the 
CheckVision application supplied with the DVD ROM, you can construct queries to search and retrieve 
cheques. Once retrieved, the cheques can be viewed, exported, batched and printed, providing fast and 
convenient access to information. 
 

System Requirements  

Component Recommended Configuration 

Memory 500MB RAM 

Mouse  
Hard Disk 50 MB fee hard drive space 

Operating System Windows 2000 (or newer) 

Overview 

In order to use this product, an encryption key library DVD ROM must first be installed to a local or 
shared disk. Upon profile set up, a onetime DVD ROM will be produced containing a random set of 
keys unique to one profile. Each regularly scheduled DVD ROM will contain your cheque images, 
the index data and one of the keys at random from the key library. The DVDs containing images and 
data can’t be viewed if the viewer can’t access the correct encryption key. Therefore, it is important 
the library be installed in such a way that the DVDs will be able to access it to match keys and 
launch the viewer. If installed correctly, the de-encryption process will be transparent to you. 
 
Refer to Appendix A for instructions and details regarding the key library. 
 

When installing the application for the first time, the volume of index information for the cheques on 
the DVD ROM will import automatically. This means that searches and full functionality is available 
immediately. Once the volumes are imported, all searching, batching, printing functionality is 
available. Refer to Appendix B for instructions and details on installing the viewer application. 

Notes: 

1. Detailed information about the CheckVision viewer is available in the user manual which is provided 
with every DVD ROM and is located at: D:\Installs\Inquiry_Usermanual.pdf. You also have the option to 
include the manual in the short cut so it’s readily available without having to load a DVD ROM. 

2. All the windows and keyboard shortcuts are in Appendix A of the user manual mentioned above 
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Tool Bars 

Main Viewer Toolbar 

The viewer’s toolbar works much the same as most windows-based tool bars. 
 

  Search icon - Click on this to perform a search 

   Screen Navigation icons - First, Previous, Next, Last 

 Batch icon - Drag and drop cheques into this folder from the results list either one at a time or a 
selection of multiple items. Select a range of items by clicking on the first item, holding down the shift key 
and then clicking on the last item. Then drag the items into the folder. Select items individually by holding 
down the Ctrl key and clicking on only the items you want from the results list. Then drag the items into 
the folder. 

 History icon - This button becomes active any time there is history associated with the cheque. A 
style sheet will display the cheques history once you click on this button. (Refer to appendix C for a 
sample style sheet) 

Cheque Display Toolbar 

 

Open icon – display an image previously saved in a file folder 

Save icon - save the current image displayed in another folder 

              Copy icon – click to copy the entire content of the display window (this will put a copy of the front 

and the back of the cheque onto the windows clipboard so you can paste it into another document   
Copy Area icon – this will allow you to select the area of interest by clicking and dragging the 

outline over the area. This will copy the selection only to the windows clipboard so you can paste it into 
another document. 

 Print icon – clicking this button will send the print job (image) to the default printer already set up by 
you. Also printed on the page will be: 
Processing date, Account, Amount, Serial #, R/T and ISN 

Print Preview icon - displays what the item will look like printed 

Lock/Unlock Window icon – Typically used when viewing more than 1 cheque at a time. Prevents the 
cheque image from changing when viewing other cheques (refer to “selecting cheques for viewing” 
section for more detail) 

 Define/Undefine icon – Saves the current viewing settings and area of interest in the Cheque 
Display window and applies them to all subsequent images viewed. Pressing the button a second time 

resets to normal cheque viewing. 

 IRD Mode icon – IRDs (Image Replacement Documents) are sometimes used in the US rather 
than physical cheques and the size of the IRDs are smaller than a standard cheque. Using this button 

when viewing an IRD will display the image in the best resolution and settings for its size.  
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Front/Back Image icon - Displays the front or the back of the image in the active area of the box. The 
active area is the last one clicked on. If the cheque box is set up to display both the front and the back at 
the same time and you click on the front of the cheque then click on the back-image icon, the back side 
of the cheque will display. You will now see two copies of the back of the cheque. 

Rotate Right/Left icon – Rotates the active image left or right 

Zoom Out/In icon – Zooms the image in and out (make image larger or smaller) 

Reverse Video icon - Reverses the inked image 
From this To this 

  

 Zoom Signature icon - Zooms into the signature line of the cheque – signature line is pre- 

determined based on CPA standard cheque specifications. 

 Zoom Endorsement icon - Zooms in on the endorsement area of the back of the cheque – 

endorse position is pre-determined based on CPA standard endorsement placement 

specifications. 

 Zoom BoFD icon – Bank of First Deposit refers to the Financial Institution where the cheque was first 
deposited. – BoFD position is pre-determined based on CPA standard placement specifications. 

Viewer Screens 

The viewer consists primarily of three windows. 

Main Viewer Window 

• This window is the primary window used within the viewer. From this window, you can view 
cheque index information, create and maintain batches and volumes as well as configure 
viewer settings. In addition to the Main viewer window, two other windows will appear when 
the viewer is loaded. 
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Cheque Display Window (Check Image_1) 

 
• This window has an interactive tool bar and will display the cheque(s) once you click on the 

one you want from the search display list. You can minimize or click and drag to adjust the 
size as well as move it around the screen, or hide (minimize) the window. This window can’t 
be closed. 

 

Document Information Window 

 
• This window is used to display currently selected cheque information only. You cannot 

enter any information into this window. Once a cheque search has been completed, the 
information regarding any highlighted cheque is displayed in this window. You can click and 
drag to adjust the size, move it to another position on the screen, hide (minimize) the 
window or close it completely. 

Searching for Cheques 
 
The following section explains how to search for a cheque using the Search Criteria and cheque List Dialogue 
boxes. 

To begin the search the quickest method is to click on the search icon (magnifying glass). You can also 
click on Image > Search to perform the same function. 
 

 

 
 

 
The Search Criteria window of the viewer contains fields, controls and commands that allow you to 
search for a number of cheques or a single cheque. 
 

After the search criteria have been entered, you can hit Enter or the click the Retrieve button to view 
the search results. 
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Processing Date: 

This is a required field for searching items and represents the day the item was captured. The format is 
YYYYMMDD. 

For a broader range of dates or if unsure of the date (s), you can search by 4 digit year only, by 
changing the operator to LIKE (default is Between) and the wild card % or * 

For example 2007% or 2007* will find all items for all cheques processed with dates beginning with 2007. 
 

Account Number 

Search by specified account number or range of accounts for multiple account cheques. 

 

Amount 

Search by specified cheque amount or range of amounts for multiple cheques. Using the following format. 
E.g. $100.00 can be entered as 100.00 or 10000 (The viewer will input the decimal before the last two digits 
when you enter no decimal point). 

 

Serial # 

Search by specified serial number of a cheque, or range of serial numbers for multiple cheques. 

 

R/T 

Enter your 5-digit branch (transit) #, and TD Bank’s Institution # (004). The branch represents the 5 digit 
transit the cheque is drawn on. 

TD Bank’s Institution number is always 004. 

 

Currency 

Search by entering CAD for a Canadian Cheque drawn in Canadian Funds or USD for a Canadian or 
US Cheque drawn in US funds. 

 

Transaction Code (Tran Code) 

Search by entering the Transaction code. Since trans codes do not normally appear on the cheque at the 
time they are printed, assume this field can be left blank. If there are specific Tran codes used by your 
bank, please obtain that list internally for descriptions. Tran codes, if present are usually encoded on a 
cheque during physical processing for sorting/categorizing purposes. 

 

ISN 

Item Sequence Number is assigned to the cheque at the time it was processed. 
Each ISN is unique to each cheque. 

 

DR/CR 

Search by specified value of Debit or Credit. All cheques are classified as debit items since they are 
used to debit funds from the account they are drawn on. If the desired result is to see all items for a 
particular acct and or amt., just leave this field blank in the search. 
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Truncated 

References electronic based processing of cheques. 
Y = Item cleared using image of cheque and electronic information N 
= Item cleared using information from the physical paper 
 

Search Field Operators 

For each search field a number of operators (search values) are available to assist in locating the required 
cheque (s). Only one operator (value) can be active for a given search field at a given time. 
 
For example, if you receive a weekly DVD ROM and you want to search for a $100 item that was 
processed between September 23, 2007 and September 27, 2007, you could use the  “Between” 
operator for the Processing date field and the “Equal To” in the Amount Field. 
 
To view the available operators for a particular field simple click the operator button located to the right of the 

field description to list all of the search operators that are available for the field. 

Available operators are: 
 

Operator Description 

  
Equal To Search for values that match 

Between 
Search for a range of values using lower and upper 
values 

Like 

Search for values that match the pattern specified. 
The % wildcard is automatically inserted after the 
character(s) that you enter, and searches for all the 

values that start with the characters you specified. 

Greater Than 
Search for values greater than or equal to the values 
specified. 

Less Than 
Search for values less than or equal to the values 
specified. 

 

1. Entry fields are provided for you to enter search criteria. They can be text, numbers or dates depending 
on the type of field. When a search entry field has an arrow , click the arrow to select from the preset 
choices. 

2. Commands 
a. Retrieve – use to initiate a search 

b. Retrieve All – using this function a Batch can be created. It creates a batch with the items 

retrieved from the search. (see section on creating a batch for more details) 

c. Export ALL- using this function data can be exported to a different location It exports the data 
with the items retrieved from the Search (see section on Exporting data for more details) 

d. Clear– use to erase the values from all the search fields 
e. Cancel- use to cancel the search 
f. Single Item Retrieval- Retrieves single item with the search criteria entered if marked. 

Viewing Cheques/Search Results 
 
Here’s what the results screen looks like after a search. By default, the viewer is set to auto image 
retrieve so the first image displayed in the window will be the first item that was matched in the 
search (first item in the results display list). 
 
 
To display a different image: 

• Use arrow keys to highlight another item in the list using the up/down arrow key 

• With the mouse, double click on the item in the results list 
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• With your mouse, Single click on the item in the results list and click the View option from the 
main window’s tool bar 

 
The Document Information window displays all of the information about the selected cheque, and 
the Check Image window displays the cheque images. 

 

 

Working with cheque Images 

Enter the required Search criteria, being as specific as possible. The cheque(s) that meet the search 
criteria will be listed in the inquiry window. Use the scroll bars or arrows on the keyboard to move to a 
specific cheque in the list. Double clicking on an index will display the image related to that index in the 
Check Image box populate the data information in the Document Information box if you have this box 
active. 

  
First Cheque  

 
Inquiry automatically lists the first cheque that matches the 
search criteria 

Single Cheque  
 

When only one cheque matches the search criteria, inquiry 
automatically opens and displays the image and the data. 

By default 
 

Inquiry will have the image set to Auto Retrieval, which can 
be changed by going to Options > Auto Image Retrieval 
and unselecting the option. 

 

Viewing Multiple Cheques 

Inquiry also provides a function for viewing up to three images at a time. Default is set to one. To 
change this, go to Options > # of Images and select from 1, 2 or 3. Click and drag the windows to 
adjust the size and position on the screen. The changed options will remain that way with every use 
after that until you change it again. 
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Locking Cheque Image panes to view more than one cheque at the same time can be done if more 
than one Cheque Display windows are visible. You can click on the lock/unlock icon to lock the last 
active viewing pane. The active pane is always the one that is the one last you clicked on. 
 

Example of 3 locked panes. 
 

 

Importing Volumes 
 
Each time a new DVD ROM is inserted the volume is automatically imported If for some reason there is a 
need to import the volume from the DVD ROM or other location, from the menu bar, click on Volume > 
Import. The volume identifier located in the Drives window is the same volume as the one printed on 

your DVD ROM label. Click OK to complete the import 
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Cumulative Indexing 

As additional DVD ROM volumes are imported, the viewer builds a cumulative index to keep track of what 

items were located on a particular volume. By default, searches will span the contents of all volumes and 

batches imported for items matching the search criteria. Searches can be run only on specific volumes by 

going to Volume > View, clicking the desired volume and pressing Select. To search across all volumes 

again, press the Unselect button on the same screen before running another search. When viewing the 

search results, you will be told what volume contains the cheque image they are requesting to see if 

images are not saved to the hard drive. 

 
Note: In order to maintain performance, the viewer is set to purge all volumes older than 3652 days (~10 
years) by default. Going to the Options > Purge Volume menu and setting a different value can change 
this setting. 
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Printing Images 

 

Annotations or Watermarks When Printing 

Watermarks 

You can add watermarks (such as ‘VOID’) to cheque images when being displayed and printed by 
selecting Options > Watermark and entering text to be displayed. The text will remain on all images 
until you remove them. 

 

Annotations 

You can add notes or user names to anything being printed by selecting Options > Footer and entering 
the text to be displayed. The text entered will remain on all printed items until you remove them. 
 

Printing One Image 

If you click the print icon in the Cheque Display window then that image will go to the printer set up as 

a default. You can change the default printer by going to File > Print Setup and selecting a different 

printer. 

 

By default the viewer prints the front and backs of cheque images. The default images printed can be 
changed by going to Options > Print Image and choosing fronts or backs or both fronts and backs to 
be printed. The option selected will persist until you change it. 
 
Printing Multiple Images 

 
To Print multiple cheques from the results list in the Main Window follow these steps: 

1. Select the number of images to be printed on a page. Go to Options > Batch Print Format and 
select the number of images to be printed per page. 

 

 
 

2. In the results window, select the cheques to be printed. Hold down the Ctrl key and click on each of 
the cheques you want to print. Holding Shift will select cheques between the last two cheques 
selected. 

3. Go to Batch > Insert to move the cheques into the batch. Alternatively, the highlighted cheques can 
be dragged and dropped on the batch icon (folder). 

4. If necessary, move more cheques to the batch from other pages in the results list or other searches. 
5. Once you have selected all the cheques to be printed, go to Batch > Retrieval/Printing. 

Alternatively, you can click the batch icon (folder). 
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6. Click Print All. The cheques images should now be sent to the default printer. 

 

 
 
Printing Index Information 

You can print the Index Information by clicking on the Index only option. This will print the 
Index information. 
 
Image and Index options are toggles so Index only cannot be selected if Image has already been 
chosen and vice versa. 

 

Saving and Viewing Images 
 
Saving an Image 

You can save an image from the Cheque Display window. Click on the Save icon and select the 
directory where to save the image. 
 
Opening an Image 

In the Cheque Display window, click the Open icon. Navigate to the image to be opened and select open. 
This will open the saved image in the Cheque Display window. 

 

Exporting Data 

Exporting is a function used to copy the indexes into a comma separated value (CSV) file along 
with images (TIFF) and supplementary data to a folder. Export can be done from two different 
locations: 
 
Export ALL Search Records: 

 
1. Select Image > Search or select the search icon (magnifying glass). This opens the Search dialog 

box. In the Search dialog box enter the criteria to search on and click on the Export All button. 

2. A confirmation dialog box will be displayed, confirming that you wish to export the items. Click on 
OK. 
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Exporting All Confirmation Dialog Box 
 
3. An Export To Folder dialog box will appear. Click on the arrow button to display a menu of drives, 

and then click on a choice to select a drive where you want the information to be stored. 

 
 

Export To Folder Dialog Box 

 
4. An Export All dialog box will appear displaying the default Export Batch Name. You may use the 

predefined batch name or enter your own. 
 
 

 
 
 
 
 
 
 
 

 
Export All Dialog Box 

 
5. The Export All dialog box will show the status of the export in the Status field. Once the export has 

been completed the Cancel button will change to “Done”. Click on Done to clear the dialog box. 

 

 
 

Export All Status - Batch Completed Dialog Box 
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Export from a Batch (Index Only) 

To export multiple indexes in to a CSV file, select all the cheque index information you want to export 
using CTRL. Select all the items you want to export, go to Batch > Insert. Another way to do this is to 
click and drag the items directly into the batch icon (folder). Once all cheques are inserted, click Batch 
> Retrieval / Printing. 
 
To export only the index and supplementary data, select Index [w/ Hist] and then Export ALL. 
 
An Export To Folder dialog box will appear. Click on the arrow button to display a menu of drives, 
and then click on a choice to select a drive where you want the information to be stored. 
 
Export from a Batch (Index and Images) 

To export all the data i.e., indexes, images and supplementary data to a folder follow the steps: 
 
Select all the indexes to be exported using CTRL key.  Go to Batch > Insert. Another way to do this is 
to click and drag the items directly into the batch icon (folder). Once inserted you can go to the next 
page and select all the items in the same manner and insert them into to the batch as well. 
 
Once inserting is completed you can click the batch icon on the toolbar or go to Batch > Retrieval 
/ Printing. To export the data, ensure the Image checkbox is checked and select export all. 

 
The Export All dialog box will show the status of the export in the Status field. Once the export has been 
completed the Cancel button will change to Done. Click on Done to clear the dialog box. 

 

Creating Batches 
 
Batches provide a way to logically group, search, save, and print items in bulk. When batches are 
created, the images and index information are copied to a local drive. The primary advantage of creating 
a batch is that it can copy the index and image information to the hard drive, eliminating the need to 
have a DVD ROM inserted to view the images of cheques. 
 
Once a batch is created it can be imported into the volume listing where it will appear alongside other 
volumes and will behave in a similar way to a DVD ROM inserted in the drive. A batch must be 
created from a volume already imported. The batch can then be moved and/or otherwise copied for 
use elsewhere. Batches of index information and images are not encrypted on the hard drive. 
 
Create a Batch From Search Window 

Follow this procedure to create a BATCH from Retrieve All search. 
 
1. Select Image > Search. This opens the Search dialog box. 

 
2. Enter Search Criteria to define your search, and then click on the Retrieve All button. The Retrieve 

All confirmation dialog box appears. 

 
 
 
 
 
 
 

Retrieve All Confirmation Dialog Box 
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3. Click on OK. The Retrieve All dialog box appears. Make the appropriate entries and selections in the 
Retrieve All dialog box, and then click on the Retrieve button to proceed with the search. 

4. The Status field indicates that the system is retrieving data from the source. You can click on Cancel 
to stop retrieval in progress. Once retrieval has been completed, the Cancel button label changes to 
Done. Select Done to close the dialog box. All items matching the search criteria are brought into a 
batch. 

 
Create a Batch by Selecting Items (Index and Images) 

1. To batch multiple items, select all the cheques and go to Batch > Insert. Another way to do this is to 
click and drag the items directly onto the batch icon (folder). Once inserted you can go to the next 
page and select more items in the same manner and insert it to the batch. 

2. Once all items are inserted, click the batch icon on the toolbar to review all the items inserted. 

3. To retrieve the images, indexes and supplementary data to a batch, select the Image checkbox and 
then click on Retrieve All. 

 

 
4 .  The Retrieve All confirmation dialog box will appear. Select OK. 

5. Once retrieval has been completed, the Cancel button label changes to Done. Select Done to close 
the dialog box. 

Create a Batch by Selecting Items (Index only) 

Follow the same procedure as above except on step 3, ensure that the Index [w/XML] checkbox 
is selected instead of the Image checkbox before proceeding. 

 
Importing a Batch 

Once batches are created, they must be imported to the volume listing to be included in searches. One 
method of importing a batch is to select the Import Batch when done checkbox while creating a 
batch. 
 
To view currently imported batches, select Volume > View to view all imported volumes. Batches 
will appear alongside volumes. The format for the Volume ID for batch is DYYYYMMDDHHMMSS. 
 
If the Import Batch when done checkbox is not selected when a batch is created, then the batch can 
be imported later. To import a batch, navigate to the Batch > View menu, highlight the desired batch 
and select Import. Click Ok once the batch has been imported. The batch will now appear as one of the 
imported volumes. 
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Appendix A - Installing the Encryption Key Library 
 
Prior to installing the CheckVision application, please ensure the key library is installed. 
Note: If your P.C. has auto run activated the screen will automatically boot up to step 4. 
 

1. Insert the DVD ROM in your PC’s DVD-ROM drive. 
2.  Select the Start button at the lower left corner of your screen. 
3.  Select Run. Type D:\Installs\setup.exe and select OK where “D” is the drive letter 

of the DVD ROM. Alternatively, you can press the Browse button, highlight the setup 
file indicated above and press Open. 

4.  Select the language to be used, then click Next> 

 

 
 

5. Continue with the install wizard. Click Next> 
 

 
 
 

6. Confirm that the Destination Folder is C:\Program Files\CV\Keys. It is recommended 
to use the default location. (If you wish, you may select another folder to install to by 
selecting the browse button.). Click Next> to continue. 
 

 
 

7. The CheckVision Application Key will automatically install, click Finish to complete 
the install. 
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Appendix B - Installing the CheckVision Application 
 

Note: If your P.C. has auto run activated the screen will automatically boot up to step 4. 
 

1. Insert the DVD ROM in your PC DVD ROM drive. 
2. Select the Start button at the lower left corner of your screen. 
3. Select Run. Type D:\Installs\setup.exe and select OK where “D” is the drive letter of 

the DVD ROM. Alternatively, you can press the Browse button, highlight the setup 
file indicated above and press Open. 

4. Select the language to be used, then click Next> 
5. Select Install Inquiry in Normal mode (default). Click Next>. 

 

 
 

6. Follow the prompts of the Install Shield Wizard:You will also be provided a chance to 
view the CheckVision Inquiry/ARP Installation Manual for detailed installation 
instructions by clicking on the provided link. Click Install to continue with the 
installation. 

 

 
 
 

7. Choose the destination folder to install the application. The default location is 
C:\Program Files\CV. It is highly recommended to use the default location. (If you 
wish to install to another location, use the browse button to change the install 
elsewhere) 
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If this is a new installation click Next> 

 
 

8. 9. Please check the DVD ROM drive name. If your ROM drive is different than the 
default, press. Browse and select the correct drive name 

 

 
 

9. Choose the directory path for the Master Database. The default location C:\Program 
Files\CV is recommended. Click Next> 

 

 
 

10. Select a Program Folder to install. The default folder name CheckVision Application 
is recommended. Click Next> 
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11. Select the shortcuts to be installed. It is recommended that at least one of the 
options are selected. Click Next> 
 

12.  Select the desired behavior whenever an Inquiry DVD ROM is inserted. 
Depending on what option is selected, the appropriate files will be copied to the hard 
drive during installation. Click Next>. 

 

 
 

13.  If the viewer doesn’t automatically detect the location of the key library, it may 
ask you to indicate where it can be found. If so, identify the location of the key 
library. The viewer will now be installed as per the setup instructions. After the 
installation is finished, it will import the volume located on the DVD ROM. 
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Appendix C – Setting up CheckVision for Local or Shared access 

1. On your workstation make a folder in C:\ where you will copy all the data from the discs i.e.  
C:\CHKVSN 

2. Make sure you have already installed the key to your workstation. 
3. Go to My Computer and go to the folder you have created to store the data (i.e. C:\CHKVSN) 

Open My Computer a second time so that you have two windows open.  Insert a data disc into 
your drive.  Go to the second window of My Computer and explore the CD/DVD drive (usually 
D:\).   Click on Select All.   Hold down the CNTL key and click on the Installs folder so that it 
becomes unselected. Right click on one of the selected folders and select copy. 

4. Go to the other My Computer window that is open in the folder you have created where you will 
store the volumes.  Click on File, New, Folder and create a new folder to copy the data to.  Name 
it according to the month/year (i.e. OCT09) or you can name it using the V number that appears 
on the face of the disc so you can correlate the folder to the physical disc.  Once you have 
created the folder open it up in My Computer.  Right click and select Paste.  This will paste the 
data from the disc to the workstation. 

5. Remove the disc from the drive 
6. Go to Start/Programs/Checkvision Application/Checkvision Inquiry to start the viewer. 
7. Click on Setup, Local.   The default for the Volume Drive is your CD/DVD drive, usually      

D:\.Change the path of the volume drive to match the location that you created on the workstation 
to store the volumes. Click on ok. 

 

 
 

8. Click on Volume, Import. Click on the name of the folder that you created for that specific disc 
(i.e. OCT09, V090403123123432 etc.).   Then click OK.   This will import the volume.  It will list 
the actual volume ID that appears on the face of the disc when it does the import. 

9. When you click on the magnifying glass icon it will automatically list all volumes that have been 
imported as it stores the information in a cumulative index.  Because you have stored the items 
locally you should see the image for any item you do a search on.   If you cannot retrieve an 
image you can go to Volume, View and highlight a specific volume you want to work on.  Click 
on Select.  Any searches you do will automatically only be done on the volume you have 
selected. You can unselect a volume at any time and select a different volume by going to 
Volume, View. You should be able to view all items though since they are stored locally. 

10. To set up to a network share in step one you need to create a folder on a shared drive and have 
the user map that drive to their workstation in My Computer. ie Z:\CHKVSN 

11. When they get to step 7 they need to change the Volume drive to the mapped drive (ie 
Z:\CHKVSN). Repeat step 8 and 9. 
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Appendix D - History (Supplementary Data) Style Sheet 

Below is an example of what cheque history (supplementary data) will look like when opened using 
an XML compatible browser. 

 
 

                   Supplementary  Data 
 

ECP Transaction: 
 

 
 

Automated Return: 
 

 
 

Representment: 
 

 
 

Suspense Account: 
 

 
 

Endorsement: 
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Appendix E – Uninstalling the CSC Software 
 
Uninstalling the Encryption Key Library 

 
1. Click the Start menu and select Control Panel. 
 
2. Select Add or Remove Programs. 
 
3. Select Checkvision Application Key and press Remove. 
 
4. A prompt may appear asking if you would like to remove the selected application 
and all its features. Select Yes. 
 
5. When completed, select Finish. 

 
Uninstalling the CheckVision Application 
 

1. Click the Start menu and select Control Panel. 
 
2. Select Add or Remove Programs. 
 
3. Select Checkvision Application and press Remove. 
 
4. A prompt may appear asking if you would like to uninstall the CheckVision 
application. Select Yes. 
 
5. When completed, select Finish. 

 
 
Removing Backup Files 

 
1. Click the Start menu and select Run. 
 
2. In the Open box, type the word Explorer and click OK 
 
3. Navigate to the path where the application and database were installed too. 
There should be two folders called CV and CVBACKUP. By default, the paths are 
C:\Program Files\CV and C:\Program Files\CVBACKUP 
 
4. Select each folder and press the delete key. If prompted and you want to move 
the folder and contents to the recycle bin, select Yes. 
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Frequently Asked Questions (FAQs) 
 
Encryption Keys 

When will I get my key library? 

As part of the enrolment process the customer will receive a welcome letter by email advising the profile 
has been set up and a key library is on its way. It then becomes the customer’s responsibility to contact 
the Implementation Manager who sent the email and advise the key library was received. 
 
What happens if I lose the Encryption key library or it becomes corrupted? 

The original key library will be burned onto a new DVD ROM along with a new set of keys. This will 
allow you to still access DVDs with the lost or corrupted keys. All new DVDs produced after the 
replacement key library is issued, will only use the new set of keys. All DVDs will be accessible. 
 
What if I get my first DVD ROM before I get the key library? 

Contact internal support groups first who may be managing the security of the DVDs as they may have 
already installed the DVD ROM. If you are certain that the library has not been received your DVD ROM 
cannot be accessed, contact the Cash Management Support at 416 982-4567 or 1-800-668-7328, 8 a.m. 
- 8 p.m. ET (English), or 1-800-567-4455, 9 a.m. - 5 p.m. ET (French) for follow up. 

 
Making Copies 

Can I copy the DVD ROM to my hard drive? 

Yes, the DVD ROM can be copied to your hard drive as long as it meets minimum PC 
workstation requirements. 
 
Can I make copies of the DVD ROM and the key library? 

Yes, if you have a DVD burner you can make complete copies. 
 
DVD ROM Storage Capacity 

How many images fit onto a DVD ROM? 

Up to 100,000 cheques fit onto one DVD ROM (100,000 fronts and 100,000 backs) for a total of 
200,000 images 
 
Support for DVD ROM 

If I lose or have my DVD ROM corrupted, how far back can you create a DVD ROM? 

Seven years on a best effort basis, or to the date the Image Archive was originally put in place. 
 
How do I get software support should my DVD ROM fail to load? 

Contact the Cash Management Support at 416 982-4567 or 1-800-668-7328,  
8 a.m.  -  8 p.m.  ET (English), or 1-800-567-4455, 9 a.m. - 5 p.m. ET (French)for assistance. 
 
Using the CSC Software 

I’ve inserted the DVD ROM but the cheques don’t appear when I search for them. 

There can be many reasons why cheques are not appearing as expected from search results. 
Following these steps should resolve a large portion of problems. 
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First, use less restrictive search criteria to ensure the items are not inadvertently being filtered out. 
Ensure that the volume has been imported. Go to Volume > View and verify the expected volumes 
are imported. 
 
If the volume has been imported, make sure it has been selected or unselect any previously selected 
volumes. (Unselecting a volume will ensure that all volumes and batches listed will be part of any 
search criteria) This can be done from the Volume > View menu and pressing ‘Unselect’ if it is 
available. 

 
How do I load subsequent DVD ROM once the initial DVD ROM has been loaded? 

After removing the initial DVD ROM, insert the subsequent DVD ROM (s), and the volume will be 

automatically imported and will prompt you if the volume was imported already 
 
Maintenance and General usage 

What is the best way to handle and store a DVD ROM? 

A DVD ROM should always be handled by grasping its outer edges, center hole, or center hub clamping 
area. Avoid flexing the DVD ROM or exposing it to direct sunlight. DVD ROMs should be stored in 
plastic “jewel” cases rather than sleeves as cases do not contact the DVD ROMs’ surface and generally 
provide better protection against scratches, dust, light, or rapid temperature changes. Once placed in 
their cases, keeping them in a closed box, drawer or cabinet can further protect DVD ROMs. 
 
What is the shelf life of a DVD ROM? 

The shelf life is conservatively estimated between 3 and 10 years. Excessive heat, direct sunlight or 
humidity may impact the life expectancy of the DVD ROM. 


